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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Ctrl+clic ou clic droit se-
lon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T
Ouvre l’onglet Styles et Formatage du
volet latéral
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Qu’est-ce que Calc ?

Calc est le module tableur de LibreOffice. Vous pouvez saisir des données (ordinairement numé-
riques) dans un classeur puis les manipuler pour produire certains résultats.

Vous pouvez aussi saisir les données puis utiliser Calc dans un mode « Et si ? » en modifiant cer-
taines de ces données pour observer le résultat sans avoir à retaper la feuille ou le classeur en en-
tier.

Parmi les autres fonctionnalités de Calc, on trouve :

• des fonctions qui peuvent servir à créer des formules pour effectuer des calculs complexes 
sur les données ;

• des fonctions de base de données pour trier, stocker et filtrer les données ;

• des graphiques dynamiques : une large gamme de diagrammes en 2D et 3D ;

• des macros pour enregistrer et exécuter les tâches répétitives ; parmi les langages de script 
supportés, on trouve LibreOffice Basic, Python, BeanShell et JavaScript ;

• la capacité à ouvrir, modifier et enregistrer les classeurs de Microsoft Excel ;

• l’importation et l’exportation de classeurs dans de nombreux formats, parmi lesquels HTML, 
CSV, PDF et PostScript.

Compatibilité avec d’autres tableurs

Jokers

Les jokers simples, tels que l’astérisque (*), le point d’interrogation (?) et le tilde (~) provenant 
d’autres tableurs sont reconnus par LibreOffice dans l’expression des formules.

Syntaxe des formules

Par défaut, LibreOffice utilise une syntaxe propre pour les formules, dite syntaxe Calc A1, à la 
place de la syntaxe Excel A1 utilisée par Microsoft Excel. LibreOffice traduit de façon transparente 
l’une vers l’autre. Cependant, si vous avez vos habitudes avec Excel, vous désirerez peut-être 
changer la syntaxe par défaut utilisée dans Calc en sélectionnant Outils > Options dans la barre 
de menu, puis en ouvrant la page LibreOffice Calc – Formule dans la boîte de dialogue Options 
pour choisir Excel A1 ou Excel R1C1 dans la liste déroulante Syntaxe de la formule.

Vous trouverez plus d’informations sur la syntaxe des formules dans le Guide Calc, au chapitre 7, 
Formules et fonctions.

Macros

Microsoft Office utilise un code écrit en Visual Basic for applications (VBA), tandis que LibreOffice 
utilise un code Basic basé sur son API (Application Programming Interface : Interface de Program-
mation de l’Application). Bien que ces deux langages de programmation soient les mêmes, les ob-
jets et les méthodes sont différents et ne sont donc pas totalement compatibles.
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LibreOffice peut exécuter certains scripts en Visual Basic d’Excel si vous activez cette possibilité 
dans la page Chargement/enregistrement – Propriétés VBA de la boîte de dialogue Options (Ou-
tils > Options…).

Si vous désirez utiliser dans LibreOffice des macros écrites dans Microsoft Excel en utilisant le 
code de macro VBA, vous devez d’abord éditer le code dans l’EDI de LibreOffice Basic.

Pour plus d’informations sur les macros, reportez-vous au Guide Calc, chapitre 12, Macros Calc.

Classeurs, feuilles de calcul et cellules

Calc travaille avec des éléments appelés classeurs. Un classeur est constitué de plusieurs feuilles 
de calcul individuelles, contenant chacune des cellules disposées en lignes et en colonnes. Une 
cellule donnée est identifiée par son numéro de ligne et la lettre de sa colonne.

Les cellules contiennent les éléments particuliers – textes, nombres, formules, etc. – qui consti-
tuent les données à afficher et à manipuler.

Chaque classeur peut posséder jusqu’à 10 000 feuilles de calcul et chaque feuille peut posséder 
un maximum de 1 048 576 cellules individuelles et de 1 024 colonnes. Le nombre maximum de ca-
ractères dans une cellule est 32 767.

La fenêtre principale de Calc

Quand Calc démarre, la fenêtre principale s’ouvre (Figure 1). Les éléments de cette fenêtre sont 
décrits ci-dessous. Vous pouvez en afficher ou en masquer de nombreux éléments à votre gré, 
grâce au menu Affichage de la barre de menu.

En-têtes de lignes

Barre de menu Barre d’outils standard Barre d’outils formatageBarre de titre

Cellule 
active

Zone de nom 
(référence de la cellule active)

Barre de 
formule

En-têtes de 
colonnes

Volet latéral

Barre d’état
Onglet de feuille 

de calcul

Figure 1 : La fenêtre principale de Calc
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La barre de titre

La barre de titre, située tout en haut, affiche le nom du classeur ouvert. Quand celui-ci vient d’être 
créé, à partir d’un modèle ou d’un document vide, son nom est Sans nom X, où X est un nombre. 
Quand vous enregistrez le classeur pour la première fois, vous êtes invité à lui donner le nom de 
votre choix.

La barre de menu

La barre de menu est située sous la barre de titre. Quand vous cliquez sur une de ses entrées, un 
menu déroulant apparaît pour afficher les commandes. Vous pouvez personnaliser la barre de 
menu : voyez le Chapitre 14, Personnaliser LibreOffice pour plus d’informations.

La plupart des menus sont similaires à ceux des autres modules de LibreOffice, bien que les com-
mandes et les outils précis puissent varier. Les entrées particulières à Calc sont Feuille et Don-
nées ; en outre, plusieurs outils importants pour l’analyse des données se trouvent dans le menu 
Outils.

Le menu Feuille
Il contient les commandes les plus souvent utilisées pour gérer les feuilles ; par exemple In-
sérer et Supprimer des cellules, des colonnes, des lignes, des feuilles, Basculer entre les 
types de référence et Lien vers des données externes.

Le menu Données
Il contient les commandes pour manipuler les données dans votre classeur ; par exemple 
Définir la plage, Trier, AutoFiltre, Statistiques, Table dynamique, Consolider, Formulaire et 
Plan et groupe.

Le menu Outils
Ce menu contient diverses fonctions pour vous aider à vérifier et à personnaliser votre clas-
seur, par exemple Orthographe, Macros, Recherche de valeur cible, Solveur, Scénarios, Au-
dit, Protéger la feuille, Paramétrage des filtres XML et Gestionnaire des extensions.

Barres d’outils

Dans la disposition par défaut, à l’ouverture de Calc, la première barre d’outils en partant du haut, 
juste sous la barre de menu, est la barre d’outils Standard. Elle est homogène parmi toutes les ap-
plications de LibreOffice. Sa position et son utilisation, ainsi que celles des autres barres d’outils, 
sont décrites dans le chapitre 1, Présentation de LibreOffice.

La barre de formule

La barre de formule (Figure 2) est située au-dessus de la feuille de calcul dans l’espace de travail 
de Calc. Elle est ancrée de façon permanente à cette position et elle ne peut pas être rendue flot-
tante. Elle peut cependant être masquée ou affichée en sélectionnant Affichage > Barre de for-
mule dans la barre de menu.

Figure 2 : La barre de formule

De gauche à droite sur la Figure 2, la barre de formule est constituée des éléments suivants :
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la Zone de nom
Elle indique la référence de la cellule actuellement active par une combinaison d’une lettre et
d’un nombre, par exemple A1. La lettre indique la colonne et le nombre la ligne de la cellule 
sélectionnée. Si vous avez sélectionné une plage de cellules qui a reçu un nom, celui-ci est 
affiché dans cette boîte. Vous pouvez aussi taper une référence de cellule dans la zone de 
nom pour sauter à la cellule référencée. Si vous tapez le nom d’une plage nommée et que 
vous appuyez sur la touche Entrée, la plage nommée est sélectionnée et affichée.

l’Assistant Fonctions 
Il ouvre une boîte de dialogue où vous pouvez parcourir une liste des fonctions disponibles. 
Cette boîte peut être très utile, car elle indique aussi les paramètres de ces fonctions.

l’icône Sélectionner la fonction 
Quand on clique sur celle-ci, une liste déroulante offre cinq choix de fonctions : Somme, 
Moyenne, Min, Max et NB.

Figure 3 : Sélection de fonctions dans la barre de formules.

l’icône Formule 
Quand on clique sur celle-ci, Calc insère un signe égal (=) dans la cellule active et dans la 
ligne de saisie, ce qui permet de saisir la formule. La zone de nom propose alors, dans une 
liste déroulante, les fonctions les plus courantes pour vous offrir un accès rapide à leurs 
noms et à leurs syntaxes ;

la ligne de saisie
Elle affiche le contenu de la cellule active (donnée, formule ou fonction) et vous permet de 
modifier celui-ci. Pour transformer la ligne de saisie en une zone de saisie multi-ligne pour 
les très longues formules, cliquez sur le bouton de droite.

Vous pouvez aussi éditer le contenu d’une cellule directement dans celle-ci en faisant un double-
clic sur la cellule elle-même ou en appuyant sur la touche F2. Quand vous saisissez une nouvelle 
donnée, les icônes Sélectionner la fonction et Formule sont remplacées par les icônes Annuler

 et Accepter .

Remarque

Dans un classeur, le terme « fonction » va bien au-delà des simples fonctions mathéma-
tiques. Voyez le Guide Calc, Chapitre 7, Utiliser les formules et les fonctions pour plus d’in-
formations.

La barre d’état

La barre d’état de Calc (Figure 4) offre des informations sur le classeur ainsi que des moyens ra-
pides et pratiques pour modifier certaines de ses propriétés. La plupart des champs sont sem-
blables à ceux des autres modules de LibreOffice : voyez le Chapitre 1, Présentation de 
LibreOffice de ce guide et le Guide Calc, Chapitre 1, Introduction à Calc pour plus d’informations.
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Mode de 
sélection

Signature 
électronique

Information sur 
l’objet ou la cellule

Pourcentage 
de zoom

Nombre et 
numéro de page

Informations sur 
la sélection

LangueStyle de 
page

Réglage du zoomMode d’insertion Document modifié

Figure 4 : La barre d’état de Calc

La barre d’état offre un moyen rapide pour effectuer quelques opérations mathématiques sur les 
cellules sélectionnées dans la feuille de calcul. Vous pouvez en calculer la moyenne et la somme, 
compter les éléments de la sélection et plus encore en faisant un clic droit sur la zone d’informa-
tions sur la cellule dans la barre d’état puis en choisissant les opérations que vous désirez y voir 
affichées.

Le volet latéral

Le volet latéral de Calc (Affichage > Volet latéral ou Ctrl+F5) est situé à droite de la fenêtre. 
C’est un mélange de barre d’outils et de boîte de dialogue. Il est semblable à celui de Writer (pré-
senté au chapitre 1 et 4 de ce livre) et est constitué de cinq onglets : Propriétés, Styles et forma-
tage, Galerie, Navigateur et Fonctions. Chacun correspond à une icône, dans la barre d’onglets à 
droite du volet latéral, qui vous permet de passer de l’un à l’autre. Les onglets sont décrits ci-des-
sous.

Propriétés
Cet onglet contient cinq sections. À l’exception de la section Styles, ils disposent tous d’un 
bouton Plus d’options ( ) qui ouvre une boîte de dialogue avec des options supplémen-
taires. Quand elles sont ouvertes, ces boîtes de dialogue empêchent l’édition du document 
jusqu’à leur fermeture.

• La section Styles permet de choisir le style de la cellule, de l’actualiser et d’en créer de nou-
veaux.

• La section Caractères fournit les contrôles nécessaires pour formater le texte, par exemple la
police, sa taille et sa couleur. Certains contrôles, comme Exposant ( ), ne sont actifs que si
le curseur de texte est situé dans la ligne de saisie de la barre de formule ou dans la cellule.

• La section Format numérique permet de modifier rapidement le format des nombres (nombre
de décimales, monnaie, dates, pourcentage ou texte numérique) ainsi les zéros non signifi-
catifs.

• La section Alignement contrôle l’alignement du texte de diverses façons, y compris horizon-
talement et verticalement, ainsi que le retour à la ligne, le retrait, la fusion de cellules, l’orien-
tation du texte et l’empilement vertical.

• La section Apparence de cellule offre des options pour définir la couleur d’arrière-plan et le 
format des bordures (couleur et style de lignes, grille) de la cellule.
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Styles et formatage, Galerie, Navigateur
Ces onglets sont semblables à ceux de Writer. Leur utilisation est décrite plus en détails 
dans le Guide Calc.

Fonctions
Cet onglet contient une liste de fonctions organisées par catégories. C’est une version sim-
plifiée de l’assistant Fonction qui s’ouvre en sélectionnant Insertion > Fonction dans la 
barre de menu, en cliquant sur l’icône Assistant fonction dans la barre de formule ou en 
appuyant sur Ctrl+F2.

Agencement du classeur

Cellules individuelles

La partie principale de l’espace de travail de Calc affiche des cellules disposées en grille. Chacune
est placée à l’intersection d’une colonne et d’une ligne.

Au sommet des colonnes et à l’extrémité gauche des lignes, on trouve une série d’en-têtes qui 
contiennent des lettres ou des nombres. Les en-têtes de colonnes utilisent des caractères alpha-
bétiques qui commencent à A et continuent vers la droite. Les en-têtes de lignes utilisent des ca-
ractères numériques qui débutent à 1 et augmentent vers le bas.

Ces en-têtes de colonnes et de lignes forment les références des cellules qui apparaissent dans la
zone de nom de la barre de formule (Figure 2, page 3). Si les en-têtes ne sont pas visibles dans 
votre classeur, sélectionnez Affichage > Afficher les en-têtes dans la barre de menu.

Onglets de feuille de calcul

Dans Calc, chaque classeur peut contenir plusieurs feuilles de calcul. En bas de la grille de cel-
lules, se trouvent des onglets qui représentent les feuilles que votre classeur contient. Cliquer sur 
un onglet donne accès à une feuille particulière et l’affiche. Une feuille active est indiquée par un 
onglet blanc (dans la disposition par défaut de Calc). Vous pouvez aussi sélectionner plusieurs 
feuilles en appuyant sur la touche Ctrl pendant que vous cliquez sur les onglets (Voir « Sélec-
tionner des feuilles », page 14).

Pour modifier le nom par défaut d’une feuille (Feuille1, Feuille2, etc.), faites un clic droit sur l’onglet
de la feuille et sélectionnez Renommer la feuille dans le menu contextuel, ou faites un double-clic
sur l’onglet. Une boîte de dialogue s’ouvre où vous pouvez saisir un nouveau nom pour la feuille.

Pour modifier la couleur de l’onglet, faites un clic droit sur celui-ci et sélectionnez Couleur d’on-
glet dans le menu contextuel pour ouvrir la boîte de dialogue Couleur d’onglet. Choisissez votre 
couleur et cliquez sur OK. Pour ajouter de nouvelles couleurs à la palette, voyez le chapitre 14, 
Personnaliser LibreOffice.

Ouvrir des fichiers CSV

Les fichiers à Valeurs Séparées par des Virgules (Comma-Separated-Values : CSV) sont des fi-
chiers texte qui peuvent être lus, affichés et modifiés dans une seule feuille de calcul. Chaque 
ligne d’un fichier CSV représente une ligne d’une feuille de calcul. Les virgules, les points-virgules 
ou d’autres caractères sont utilisés pour séparer les cellules. Le texte peut être saisi entre des 
guillemets ; les nombres sont saisis sans guillemets.
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Remarque

La plupart des fichiers CSV proviennent de tables, requêtes et rapports de bases de don-
nées où des calculs et diagrammes supplémentaires sont nécessaires. Sous Microsoft Win-
dows, les fichiers CSV ont souvent l’extension .xls pour ressembler à des fichiers Excel mais
leur structure interne reste celle des fichiers CSV.

Pour ouvrir un fichier CSV dans Calc :

 1) Choisissez Fichier > Ouvrir dans la barre de menu et recherchez le fichier CSV que vous 
voulez ouvrir. Certains peuvent cependant avoir une extension .txt.

 2) Sélectionnez le fichier et cliquez sur Ouvrir.

 3) Dans la boîte de dialogue Import de texte (Figure 5), sélectionnez les diverses options dispo-
nibles pour importer un fichier CSV dans un classeur de Calc. Pour les détails sur ces op-
tions, voir le chapitre 1, Introduction à Calc, du Guide Calc.

 4) Cliquez sur OK pour ouvrir le fichier.

Figure 5 : Boîte de dialogue Import de texte, avec la virgule, le point-virgule et la tabulation comme
séparateurs de colonnes et le guillemet comme séparateur de texte
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Enregistrer les classeurs

Voyez le chapitre 1, Introduction à LibreOffice pour plus de détails sur la façon d’enregistrer ma-
nuellement ou automatiquement des fichiers. Calc permet aussi d’enregistrer les classeurs dans 
toute une gamme de formats et aussi de les exporter dans les formats de fichiers PDF, HTML et 
XHTML, ainsi que sous forme d’images JPEG et PNG ; voyez le Guide Calc, Chapitre 6, Imprimer,
exporter, envoyer par courriel et signer pour plus d’informations.

Enregistrer dans d’autres formats de classeurs

Vous pouvez enregistrer un classeur dans un autre format.

 1) Important : enregistrez tout d’abord votre classeur dans le format de fichier ODF utilisé par 
LibreOffice, *.ods. Si vous ne le faites pas, toutes les modifications que vous aurez pu effec-
tuer depuis le moment de votre dernier enregistrement apparaîtront uniquement dans la nou-
velle version du document.

 2) Sélectionnez Fichier > Enregistrer sous dans la barre de menu pour ouvrir la boîte de dia-
logue Enregistrer sous.

 3) Dans la zone de saisie Nom de Fichier, vous pouvez saisir un nouveau nom pour votre clas-
seur.

 4) Dans la liste déroulante Type, sélectionnez le type de format que vous désirez utiliser.

 5) Si l’option Extension automatique du nom de fichier est cochée, l’extension correcte pour le 
format que vous avez sélectionné sera ajoutée au nom du fichier.

 6) Cliquez sur Enregistrer.

Chaque fois que vous cliquez sur Enregistrer, la boîte de dialogue Confirmer le format de fichier 
(Figure 6) s’ouvre. Cliquez sur Utiliser le format XXX … pour terminer l’enregistrement dans le 
format que vous avez choisi ou cliquez sur Utiliser le format ODF pour enregistrer le classeur 
dans le format .ods de Calc.

Figure 6 : Message de confirmation lors de l’enregistrement dans un format autre qu’ODF

Si vous choisissez le format Texte CSV (*.csv) pour votre classeur, la boîte de dialogue Export de 
fichiers texte (Figure 7) s’ouvre. Vous pouvez y choisir le jeu de caractères, le séparateur de 
champ, le séparateur de texte, etc. à utiliser pour le fichier CSV.
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Figure 7 : Choix des options lors de l’export en Texte CSV

! Attention

À partir de ce moment, toutes les modifications que vous apporterez au classeur au-
ront lieu uniquement dans le document au nouveau format. Vous avez changé le nom 
et le type de fichier de votre document. Si vous voulez recommencer à travailler avec la ver-
sion *.ods de votre classeur, vous devez l’ouvrir à nouveau.

Une autre solution consiste à utiliser la commande Enregistre une copie, plutôt que Enre-
gistrer sous : dans ce cas, les nouvelles modifications sont toujours faites dans le fichier au
format original.

Conseil

Pour que Calc enregistre par défaut les documents dans un format autre que ODF, sélec-
tionnez Outils > Options dans la barre de menu ; dans la boîte de dialogue Options, ouvrez
la page Chargement/Enregistrement – Général. Dans la section Format de fichier par dé-
faut et paramétrage ODF, sélectionnez Classeur dans la liste déroulante Type de docu-
ment et votre format favori dans la liste déroulante Enregistrer systématiquement sous.

Exporter le contenu sous forme d’image

Si vous désirez envoyer une partie de votre classeur à un collègue ou la publier sur Internet, Calc 
peut exporter une sélection de cellules ou un groupe de formes sélectionnées (figures) au format 
d’image JPG ou PNG.

 1) Sélectionnez les cellules ou le groupe de figures dans votre classeur, puis choisissez Fichier
> Exporter dans la barre de menu.

 2) Dans la boîte de dialogue Exporter, saisissez un nom pour votre image dans le champ Nom 
de fichier, sélectionnez le format de fichier dans la liste déroulante Type et cochez la case 
Sélection.

 3) Cliquez sur le bouton Exporter ou Enregistrer selon le cas.

Il se peut que Calc ouvre une autre boîte de dialogue pour vous permettre de configurer les para-
mètres associés au format d’image choisi.
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Naviguer dans les classeurs

Calc propose de nombreuses façons de naviguer à l’intérieur d’un classeur, de cellule à cellule et 
de feuille à feuille. Vous pouvez en général utiliser la méthode que vous préférez.

Déplacement d’une cellule à l’autre

Quand une cellule est sélectionnée ou activée, ses bordures sont plus épaisses. Quand un groupe
de cellules est sélectionné, l’espace des cellules est coloré. La couleur de la bordure de la cellule 
activée et celle du groupe sélectionné dépendent du système d’exploitation utilisé et de la façon 
dont vous avez configuré LibreOffice.

• Utiliser la souris : placez le pointeur de la souris sur la cellule et cliquez avec le bouton 
gauche de la souris.

• Utiliser une référence de cellule : effacez la référence de cellule qui se trouve dans la zone
de nom de la barre de formule (Figure 2, page 3). Tapez la référence de la cellule où vous 
voulez aller et appuyez sur Entrée. Les références de cellules peuvent être saisies en ma-
juscules ou en minuscules : a3 ou A3, par exemple, sont identiques.

• Utiliser le navigateur : appuyez sur F5 pour afficher le navigateur, ou cliquez sur l’onglet du 
Navigateur dans le volet latéral. Tapez la référence de cellule dans les deux champs du haut,
intitulés Colonne et Ligne, ou utilisez les boutons à leur droite et appuyez sur Entrée. Dans 
la Figure 8, le Navigateur sélectionnera la cellule A1.

Figure 8 : Le navigateur de Calc

• Utiliser les touches Tab et Entrée

– Appuyer sur Entrée ou Maj+Entrée active respectivement par défaut la cellule au-des-
sous et au-dessus de la cellule actuellement active dans la même colonne.

– Appuyer sur Tab ou Maj+Tab active respectivement la cellule à droite et à gauche de la 
cellule actuellement active sur la même ligne.
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• Utiliser les touches flèches : Appuyer sur les touches flèches du clavier déplace le focus 
dans la direction des flèches.

• Utiliser Début, Fin, Page précédente et Page suivante

– Début active la première cellule d’une ligne.

– Fin active la cellule la plus à droite de la ligne et qui contient une donnée.

– Page suivante (PgSuiv) active la cellule écran complet en dessous en faisant défiler
l’affichage.

– Page précédente (PgPrec) active la cellule écran complet au-dessus en faisant défi-
ler l’affichage.

Déplacement d’une feuille à l’autre

Chaque feuille d’un classeur est indépendante des autres, bien qu’elles puissent être liées par des 
références de l’une à l’autre. Il y a trois façons de naviguer entre les différentes feuilles d’un clas-
seur.

• Avec le navigateur – Dans le navigateur (Figure 8, page 10), cliquez sur le symbole + à cô-
té de Feuilles pour voir la liste des feuilles du classeur. Faites un double clic sur la feuille que
vous voulez atteindre.

• Avec le clavier – Appuyez sur Ctrl+Page suivante pour vous déplacer d’une feuille vers
la droite et appuyez sur Ctrl+Page précédente pour vous déplacer d’une feuille vers la 
gauche.

• Avec la souris – Cliquer sur un des onglets en bas du classeur permet de sélectionner la 
feuille correspondante.

Si votre classeur contient beaucoup de feuilles, certains des onglets peuvent alors être cachés. Si 
c’est le cas :

• Les quatre boutons à la gauche des onglets peuvent alors faire apparaître les onglets ca-
chés. La Figure 9 montre comment le faire.

Figure 9 : Flèches d’onglet des feuilles

• Un clic droit sur un des boutons ouvre un menu contextuel où vous pouvez sélectionner une 
feuille (Figure 10).
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Figure 10 : Un clic droit sur un des cinq boutons

Remarques

Quand vous insérez une nouvelle feuille dans un classeur, Calc utilise automatiquement le 
nombre suivant dans la séquence utilisée pour former le nom. Selon la feuille ouverte quand
vous en insérez une nouvelle, elle peut ne pas être à la position correspondant à son numé-
ro. La liste de la Figure 10 indique que Feuille5 est en quatrième position parmi les sept 
feuilles du classeur. Il est recommandé de renommer les feuilles pour les reconnaître plus 
facilement.

Navigation avec le clavier

Vous pouvez parcourir un classeur avec le clavier, en appuyant sur une touche ou une combinai-
son de touches. Voir l’annexe A, Raccourcis clavier, du Guide Calc pour les touches et combinai-
sons de touches que vous pouvez utiliser pour vous déplacer dans un classeur.

Personnaliser la touche Entrée

Vous pouvez personnaliser la direction dans laquelle la touche Entrée déplace l’activation de la 
cellule en ouvrant la page LibreOffice Calc – Général de la boîte de dialogue Options (Outils > 
Options dans la barre de menu). Sélectionnez la direction du mouvement dans la liste déroulante. 
Selon le fichier utilisé ou le type de données saisies, une direction différente peut être utile. La 
touche Entrée peut aussi être utilisée pour passer en et hors mode d’édition. Utilisez les deux 
premières options sous Paramètres de saisie (Figure 11) pour changer le paramétrage de la 
touche Entrée.

Figure 11 : Personnaliser la touche Entrée
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Sélectionner des éléments dans un classeur

Sélectionner des cellules

Cellule individuelle

Faites un clic gauche dans la cellule. Vous pouvez vérifier votre sélection en regardant dans la 
zone de nom de la barre de formule (Figure 1 page 2).

Plage de cellules contiguës

Vous pouvez sélectionner une plage de cellules en utilisant le clavier ou la souris.

Pour sélectionner une plage de cellules en faisant glisser la souris :

 1) Cliquez dans une cellule.

 2) Appuyez et gardez appuyé le bouton gauche de la souris.

 3) Déplacez la souris sur l’écran pour sélectionner les cellules désirées puis relâchez le bouton 
gauche de la souris.

Pour sélectionner une plage de cellules sans faire glisser la souris :

 1) Cliquez dans la cellule qui sera un des coins de la plage de cellules.

 2) Cliquez en appuyant sur la touche Maj dans le coin opposé de la plage de cellules.

Conseil

Vous pouvez aussi sélectionner une plage de cellules contiguës en commençant par cliquer 
sur le champ Mode de sélection de la barre d’État (Figure 4 page 5) et en choisissant Sé-
lection étendue avant de cliquer sur les coins opposés de la plage de cellules. Assurez-
vous de revenir à Sélection standard ou vous pourriez vous retrouver en train d’étendre in-
volontairement une sélection de cellules.

Pour sélectionner une plage de cellules sans utiliser la souris :

 1) Sélectionnez la cellule qui sera un des coins de la plage de cellules.

 2) En gardant appuyée la touche Maj, utilisez les flèches du curseur pour sélectionner le reste 
de la plage.

Conseil

Vous pouvez également sélectionner directement une plage de cellules en utilisant la zone 
de nom de la barre de formule (Figure 1 page 2). Pour sélectionner une plage de cellules, 
saisissez la référence de cellule du coin supérieur gauche, suivi de deux points (:), et en-
suite de la référence de cellule du coin inférieur droit. Par exemple, pour sélectionner la 
plage qui va de A3 à C6, vous saisiriez A3:C6.

Plage de cellules non contiguës

 1) Sélectionnez la cellule ou la plage de cellules en utilisant une des méthodes ci-dessus.

 2) Déplacez le pointeur de la souris vers le début de la prochaine plage ou cellule individuelle.
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 3) Maintenez appuyée la touche Ctrl et cliquez et faites glisser pour sélectionner une autre 
plage de cellules à ajouter à la première plage.

 4) Répétez autant que nécessaire.

Sélectionner des colonnes et des lignes

Colonne ou ligne individuelle

Pour sélectionner une colonne individuelle, cliquez sur l’en-tête de la colonne (voir Figure 1 page
2). Pour sélectionner une ligne individuelle, cliquez sur l’en-tête de la ligne.

Colonnes ou lignes multiples

Pour sélectionner plusieurs colonnes ou lignes contiguës :

 1) Cliquez sur l’en-tête de la première colonne ou ligne du groupe.

 2) Cliquez sur l’en-tête de la dernière colonne ou ligne du groupe en appuyant sur la touche 
Maj.

Pour sélectionner plusieurs colonnes ou lignes multiples non contiguës :

 1) Cliquez sur l’en-tête de la première colonne ou ligne du groupe.

 2) Cliquez sur les en-têtes de toutes les colonnes ou lignes à sélectionner en appuyant sur la 
touche Ctrl.

Feuille entière

Pour sélectionner la feuille entière, cliquez dans la petite boîte entre l’en-tête de colonne A et celui 
de ligne 1 (Figure 12). Vous pouvez également appuyer sur Ctrl+A ou Ctrl+Maj+Espace pour 
sélectionner la feuille entière ou sélectionner Édition > Tout sélectionner dans la barre de menu.

Figure 12 : Boîte Tout sélectionner

Sélectionner des feuilles

Vous pouvez sélectionner une ou plusieurs feuilles. Il peut être intéressant de sélectionner plu-
sieurs feuilles en même temps si vous voulez y effectuer des modifications en une seule fois.

Feuille individuelle

Cliquez sur l’onglet de la feuille que vous voulez sélectionner. L’onglet de la feuille active devient 
blanc dans le paramétrage par défaut de Calc (voir Figure 9 page 11).

Plusieurs feuilles contiguës

Pour sélectionner plusieurs feuilles contiguës :

 1) Cliquez sur l’onglet de la première feuille désirée.

 2) Cliquez sur l’onglet de la dernière feuille à sélectionner en appuyant sur la touche Maj.
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Tous les onglets entre ces deux feuilles deviennent blancs (avec le paramétrage par défaut). 
Toutes les actions que vous effectuerez affecteront désormais toutes les feuilles sélectionnées.

Plusieurs feuilles non contiguës

Pour sélectionner plusieurs feuilles non contiguës :

 1) Cliquez sur l’onglet de la première feuille désirée.

 2) Cliquez sur l’onglet de la dernière feuille à sélectionner en appuyant sur la touche Ctrl.

 3) Répétez autant que nécessaire.

Les onglets sélectionnés deviennent blancs (avec le paramétrage par défaut). Toutes les actions 
que vous effectuerez affecteront désormais toutes les feuilles sélectionnées.

Toutes les feuilles

Faites un clic droit sur l’un des onglets et choisissez Sélectionner toutes les feuilles dans le 
menu contextuel ou dans le sous-menu Édition > Sélectionner de la barre de menu.

Pour désélectionner

Pour revenir au fonctionnement par défaut avec une seule feuille sélectionnée, il suffit de cliquer 
sur l’onglet d’une feuille non sélectionnée. Si toutes les feuilles sont sélectionnées, faites un 
Ctrl+clic sur un des onglets.

Remarque

Si une couleur d’onglet a été définie pour une feuille, lorsque cette feuille est sélectionnée, 
la couleur n’apparaît qu’en bas de l’onglet et le reste de la zone devient blanc.

! Attention

Une fois les modifications effectuées sur les différentes feuilles, pensez à revenir à une 
seule feuille sélectionnée, sinon vos modifications continueront à s’appliquer à toutes les 
feuilles. Pour cela, cliquez sur l’onglet d’une feuille non sélectionnée.

Gérer les colonnes et les lignes

Insérer des colonnes et des lignes

Avec le menu Feuille :

 1) Sélectionnez la cellule, colonne ou ligne où vous voulez insérer la nouvelle colonne ou ligne.

 2) Choisissez soit Feuille > Insérer des colonnes > Colonnes avant ou Colonnes après soit 
Feuille > Insérer des lignes > Lignes au-dessus ou Lignes en dessous dans la barre de 
menu.

Avec la souris :

 1) Sélectionnez la colonne ou la ligne où vous voulez insérer la nouvelle colonne ou ligne.

 2) Faites un clic droit sur l’en-tête de colonne ou de ligne.

Gérer les colonnes et les lignes | 15



 3) Choisissez Insérer des colonnes avant, Insérer des colonnes après, Insérer des lignes 
au-dessus ou Insérer des lignes au-dessous dans le menu contextuel.

Colonnes ou lignes multiples

Les colonnes ou lignes multiples peuvent être insérées en une fois plutôt qu’une par une.

 1) Mettez en surbrillance le nombre voulu de colonnes ou de lignes : cliquez sur l’en-tête de la 
première puis faites glisser la souris sur les en-têtes en gardant appuyé le bouton gauche.

 2) Procédez comme pour insérer une seule colonne ou ligne ci-dessus.

Masquer et afficher des lignes et des colonnes

Pour masquer des lignes ou des colonnes

 1) Sélectionnez les colonnes ou les lignes que vous souhaitez masquer.

 2) Choisissez Format > Lignes > Masquer ou Format > Colonnes > Masquer. Vous pouvez 
aussi faire un clic droit sur l’en-tête de la ligne ou de la colonne puis choisir Masquer des 
lignes ou Masquer des colonnes dans le menu contextuel.

Pour afficher des lignes ou des colonnes masquées

 1) Sélectionnez les colonnes ou les lignes de part et d’autre des colonnes ou des lignes mas-
quées.

 2) Choisissez Format > Lignes > Afficher ou Format > Colonnes > Afficher. Vous pouvez 
aussi faire un clic droit sur l’en-tête de la ligne ou de la colonne puis choisir Afficher les 
lignes ou Afficher les colonnes dans le menu contextuel.

Supprimer des colonnes et des lignes

 1) Sélectionnez les colonnes ou les lignes que vous souhaitez supprimer.

 2) Choisissez Feuille > Supprimer des lignes ou Feuille > Supprimer des colonnes. Vous 
pouvez aussi faire un clic droit sur l’en-tête de la ligne ou de la colonne puis choisir Suppri-
mer des lignes ou Supprimer des colonnes dans le menu contextuel.

Supprimer des cellules

 1) Sélectionnez les cellules à supprimer.

 2) Choisissez Feuille > Supprimer des cellules dans la barre de menu, faites un clic droit et 
choisissez Supprimer dans le menu contextuel ou appuyez sur Ctrl+-.

 3) Cochez l’option dont vous avez besoin dans la boîte de dialogue Supprimer des cellules (Fi-
gure 13).
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Figure 13 : La boîte de dialogue Supprimer des cellules

Gérer les feuilles

Insérer de nouvelles feuilles

Il y a plusieurs façons d’insérer une nouvelle feuille. La méthode la plus rapide est de cliquer sur le
bouton Ajouter une feuille  (voir Figure 9, page 11). Elle insère une nouvelle feuille après la 
dernière, sans ouvrir la boîte de dialogue Insérer une feuille.

Les méthodes suivantes ouvrent la boîte de dialogue Insérer une feuille (Figure 14) où vous pou-
vez insérer plus d’une feuille, renommer la feuille, insérer la feuille ailleurs dans la séquence ou 
choisir une feuille dans un fichier.

Figure 14 : La boîte de dialogue Insérer une feuille

• Sélectionnez les feuilles près desquelles la nouvelle feuille va être insérée, puis choisissez 
Feuille > Insérer une feuille dans la barre de menu.

• Faites un clic droit sur l’onglet près duquel vous voulez insérer la nouvelle feuille ou dans 
l’espace vide après les onglets et choisissez Insérer une feuille dans le menu contextuel.
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• Cliquez sur un espace vide à la fin de la ligne des onglets.

Déplacer et copier des feuilles

Vous pouvez déplacer ou copier des feuilles dans le même classeur par glisser/déposer ou en utili-
sant la boîte de dialogue Déplacer/copier la feuille. Pour déplacer ou copier une feuille dans un 
autre classeur, vous devez utiliser cette boîte de dialogue.

Dans la boîte de dialogue Déplacer/copier la feuille (Figure 15) vous pouvez spécifier exactement 
si vous voulez déplacer ou copier la feuille dans le même classeur ou dans un autre, indiquer sa 
position dans le classeur et son nom.

Figure 15 : La boîte de dialogue Déplacer/copier la feuille

 1) Dans le document en cours, faites un clic droit sur l’onglet de la feuille que vous voulez co-
pier ou déplacer puis sélectionnez Déplacer/copier la feuille dans le menu contextuel ou 
choisissez Feuille > Déplacer/copier la feuille de la barre de menu.

 2) Dans la section Action, cochez celle que vous désirez effectuer.

 3) Choisissez le classeur où vous désirez placer la feuille dans la liste déroulante Vers le docu-
ment. Cela peut être le même classeur, un autre classeur déjà ouvert ou un nouveau clas-
seur.

 4) Définissez dans Insérer avant la position où vous voulez placer la feuille.

 5) Tapez un nom dans la boîte de texte Nouveau nom si vous voulez renommer la feuille en la 
déplaçant ou en la copiant. Si vous ne précisez pas de nom, Calc en crée un par défaut 
(Feuille2, Feuille3, etc.).

 6) Cliquez sur OK pour confirmer l’opération et fermer la boîte de dialogue.

! Attention

Si vous choisissez comme document de destination un autre classeur ouvert ou - nouveau 
document –, cela peut créer des conflits pour les formules liées à d’autres feuilles du docu-
ment d’origine.
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Masquer et afficher des feuilles

Vous voudrez peut-être parfois cacher le contenu d’une feuille pour éviter qu’il soit accidentelle-
ment modifié ou parce qu’il n’est pas important de l’afficher.

Pour masquer une ou plusieurs feuilles, sélectionnez-les comme indiqué ci-dessus, faites un clic 
droit sur une des feuilles sélectionnées et choisissez Masquer la feuille dans le menu contextuel.

Pour afficher les feuilles masquées, faites un clic droit sur un onglet et choisissez Afficher les 
feuilles dans le menu contextuel. Une boîte de dialogue s’ouvre avec la liste des feuilles mas-
quées. Sélectionnez-y les feuilles à afficher puis cliquez sur OK.

Remarque

LibreOffice Calc ne vous permet pas de masquer la dernière feuille visible.

Renommer des feuilles

Le nom par défaut d’une nouvelle feuille est FeuilleX, où Feuille est le préfixe défini dans Outils > 
Options > LibreOffice Calc > Par défaut et X est un numéro. Si cela convient pour un petit clas-
seur avec seulement quelques feuilles, cela devient moins lisible lorsqu’il y en a beaucoup.

Pour donner à une feuille un nom plus significatif, vous pouvez :

• saisir le nom dans la zone de saisie Nom (Figure 14 page 17) quand vous créez la feuille 
avec la boîte de dialogue Insérer une feuille ;

• faire un clic droit sur l’onglet et choisir Renommer la feuille dans le menu contextuel ; rem-
placer le nom existant par un nouveau.

• faire Alt+Clic sur l’onglet pour y modifier directement le nom ;

• faire un double-clic sur l’onglet pour ouvrir la boîte de dialogue Renommer la feuille.

Remarque

Les noms de feuilles doivent être uniques dans le classeur et commencer par une lettre ou 
un chiffre ; les autres caractères, y compris l’espace ne sont pas autorisés. La suite du nom 
ne doit être constituée que de lettres, de chiffres, d’espaces et de caractères de souligne-
ment (_). Tenter de donner un nom incorrect à une feuille produit un message d’erreur.

Supprimer des feuilles

Pour supprimer une seule feuille, choisissez Supprimer des feuilles dans le menu contextuel, ou 
dans le menu Feuille de la barre de menu. Cliquez sur Oui pour confirmer la suppression.

Pour supprimer plusieurs feuilles, sélectionnez-les comme décrit auparavant (« Sélectionner des 
feuilles » page 14), puis choisissez Supprimer des feuilles dans le menu contextuel, ou dans le 
menu Feuille de la barre de menu. Cliquez sur Oui pour confirmer la suppression.
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Affichage de Calc

Modifier l’affichage du document

Utilisez la fonction zoom (Affichage > Zoom) pour afficher plus ou moins de cellules dans la fe-
nêtre pendant que vous travaillez sur un classeur. Pour plus de renseignements sur le zoom, 
voyez le chapitre 1, Présentation de LibreOffice dans ce guide.

Fixer les lignes et les colonnes

Le fait de fixer verrouille un certain nombre de lignes en haut d’un classeur et un certain nombre 
de colonnes à sa gauche ou les deux à la fois. Quand vous vous déplacez ensuite dans une 
feuille, les cellules des lignes et colonnes figées restent toujours visibles.

La Figure 16 montre quelques lignes et colonnes fixées. Le trait horizontal plus épais entre les 
lignes 4 et 14 ainsi que le trait vertical entre les colonnes B et G indiquent que les lignes 1 à 4 et 
les colonnes A et B sont figées. Les lignes de 5 à 13 et les colonnes de C à F ont été décalées 
hors de l’affichage.

Figure 16 : Lignes et colonnes fixées

La première ligne et la première colonne contiennent souvent des en-têtes que vous aurez peut-
être envie de maintenir visibles pendant que vous parcourez une feuille haute et large. Pour fixer 
rapidement l’une ou les deux, utilisez les commandes du menu déroulant du bouton Fixer lignes 
et colonnes ( ) de la barre d’outils Standard : Fixer la première colonne et Fixer la première 
ligne. Vous pouvez aussi utiliser Affichage > Fixer des cellules > Fixer la première colonne ou 
Fixer la première ligne.

Pour fixer des lignes ou des colonnes,

 1) Cliquez sur l’en-tête de la ligne sous celle que vous voulez fixer ou sur l’en-tête de la colonne
à droite de celle que vous voulez fixer.

 2) Faites un clic droit sur l’en-tête et choisissez Fixer lignes et colonnes dans le menu contex-
tuel ou dans le menu Affichage ou cliquez sur le bouton Fixer lignes et colonnes ( ) de 
la barre d’outils Standard.

Pour fixer des lignes et des colonnes à la fois,

 1) Cliquer dans la cellule immédiatement sous les lignes et à droite des colonnes que vous vou-
lez fixer.

 2) Sélectionner Affichage > Fixer lignes et colonnes dans la barre de menu ou cliquer sur 
l’icône Fixer lignes et colonnes ( ) dans la barre d’outils Standard. Une ligne plus épaisse
apparaît entre les lignes et les colonnes fixées et libres.
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Libérer les lignes et les colonnes figées

Pour libérer les lignes ou les colonnes, sélectionnez Affichage > Fixer des cellules > Fixer 

lignes et colonnes dans la barre de menu ou cliquez sur l’icône Fixer lignes et colonnes  
dans la barre d’outils Standard. Les traits plus épais qui marquent les lignes et colonnes fixées dis-
paraîtront et les lignes et colonnes libres qui étaient masquées réapparaîtront.

Scinder l’écran

Une autre façon de changer l’affichage consiste à scinder la fenêtre. L’écran peut être scindé hori-
zontalement, verticalement, ou les deux. Vous pouvez par conséquent avoir jusqu’à quatre por-
tions de la feuille affichées en même temps comme sur la Figure 17. À la différence de la com-
mande Fixer lignes colonnes, scinder l’écran permet de conserver une barre de défilement dans 
chaque partie de la fenêtre.

Cela pourrait, par exemple, être utile avec un grand classeur dans lequel une des cellules contient 
un nombre qui est utilisé par trois formules dans d’autres cellules. En scindant l’écran, vous pou-
vez positionner la cellule contenant le nombre dans une section et chacune des cellules avec for-
mule dans les autres sections. Vous pouvez alors changer le nombre dans la cellule et voir com-
ment cela affecte les résultats de chacune des formules.

Figure 17 : Exemple d’écran scindé

Comment scinder l’écran horizontalement ou verticalement

Il y a deux façons de scinder un écran horizontalement ou verticalement.

Méthode 1

Pour partager l’écran soit horizontalement, soit verticalement :

 1) Cliquez sur l’en-tête de la ligne sous celles où vous voulez scinder l’écran horizontalement 
ou sur l’en-tête de la colonne à droite de celles où vous voulez scinder l’écran verticalement.

 2) Sélectionnez Scinder la fenêtre dans le menu contextuel ou dans le menu Affichage. Une 
ligne plus épaisse apparaît entre les lignes et les colonnes qui délimitent le partage (voir Fi-
gure 17).

Pour partager l’écran en même temps horizontalement et verticalement :

 1) Cliquez dans la cellule immédiatement sous la ligne où vous voulez scinder l’écran horizon-
talement et immédiatement à droite de la colonne où vous voulez le scinder verticalement.

 2) Sélectionnez Affichage > Scinder la fenêtre dans la barre de menu.
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Méthode 2

Pour scinder horizontalement, cliquez sur la petite ligne foncée épaisse tout en haut de la barre de 
défilement verticale (Figure 18) et tirer la nouvelle bordure de fenêtre horizontale sous la ligne où 
vous voulez placer le partage horizontal.

De la même façon, pour scinder verticalement, cliquez sur la petite ligne foncée épaisse à l’extré-
mité droite de la barre de défilement horizontale et tirez la nouvelle bordure de fenêtre verticale à 
droite de la colonne où vous voulez placer le partage vertical.

Tirez ici pour partager la fenêtre verticalement

Tirez ici pour partager la fenêtre horizontalement

Figure 18 : Partage interactif de la fenêtre

Supprimer le partage de l’écran

Pour annuler un partage de l’écran,

• faites un double-clic sur chaque ligne de partage,

• replacez les bordures de fenêtres scindées à leur position aux extrémités des barres de défi-
lement (Figure 18),

• cliquez sur Affichage > Scinder la fenêtre dans la barre de menu pour décocher l’option.

• faites un clic droit sur un en-tête de ligne ou de colonne et cliquez sur Scinder la fenêtre 
dans le menu contextuel.

Saisir des données en utilisant le clavier

La plupart des saisies de données dans Calc peuvent être faites en utilisant le clavier.

Saisir des nombres

Cliquez dans la cellule et tapez le nombre en utilisant les touches numériques soit de la partie prin-
cipale du clavier, soit du pavé numérique. Par défaut, les nombres sont alignés à droite dans une 
cellule.

Nombres négatifs

Pour saisir un nombre négatif, tapez le signe moins (–) devant celui-ci ou placez-le entre paren-
thèses, par exemple (1234).

Zéros non significatifs

Si vous désirez conserver un nombre minimum de chiffres dans une cellule contenant un nombre 
avec un format numérique défini, par exemple 1234 et 0012, des zéros non significatifs doivent 
être ajoutés à l’aide d’une des méthodes suivantes :
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Méthode 1

 1) La cellule étant active, ouvrez la boîte de dialogue Formatage des cellules (Figure 19) en fai-
sant un clic droit dans la cellule et sélectionnez Formater des cellules dans le menu contex-
tuel, en sélectionnant Format > Cellules dans la barre de menu, en utilisant le raccourci 
Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres est sélectionné puis choisissez Nombre dans la liste Catégo-
rie.

 3) Dans le champ Zéros non significatifs de la section Options, saisissez le nombre minimum 
de caractères nécessaires. Par exemple, pour quatre caractères, tapez 4. Tout nombre ayant
moins de quatre chiffres sera précédé de zéros non significatifs, par exemple 12 deviendra 
0012.

 4) Cliquez sur OK. Le nombre saisi conserve son format numérique et toute formule utilisée 
dans le classeur traitera l’entrée comme un nombre dans les fonctions des formules.

Figure 19: L’onglet Nombres de la boîte de dialogue Formatage des cellules.

Méthode 2

 1) Sélectionnez la cellule.

 2) Dans le volet latéral, ouvrez l’onglet Propriétés puis la section Format numérique (cliquez 
sur le + ou ˅ pour ouvrir celui-ci) (Figure 20).

 3) Choisissez Nombre dans la liste déroulante située sous le titre de la section Format numé-
rique.

 4) Tapez 4 dans le champ Zéros non significatifs. Le format est immédiatement appliqué.
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Figure 20: Définir le nombre de zéros non significatifs

Conseil

Si une suite de chiffres n’est pas destinée à être traitée comme un nombre dans des calculs 
(par exemple, un code postal), vous pouvez taper une apostrophe (‘) avant les chiffres : par 
exemple ‘09820. Quand vous activez une autre cellule, l’apostrophe est supprimée, les zé-
ros non significatifs conservés et la suite de chiffres convertie en texte aligné à gauche.

Nombres sous forme de texte

Les nombres peuvent aussi être saisis sous forme de texte grâce à l’une des méthodes suivantes :

Méthode 1

 1) La cellule étant active, ouvrez la boîte de dialogue Formatage des cellules (Figure 19) en fai-
sant un clic droit dans la cellule et sélectionnez Formater des cellules dans le menu contex-
tuel, en sélectionnant Format > Cellules dans la barre de menu, en utilisant le raccourci 
Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres est sélectionné puis choisissez Texte dans la liste Catégorie.

 3) Cliquez sur OK. Le nombre saisi est converti en texte et aligné par défaut à gauche.

Méthode 2

 1) Sélectionnez la cellule.

 2) Dans le volet latéral, ouvrez l’onglet Propriétés puis la section Format numérique (cliquez 
sur le + ou ˅ pour ouvrir celui-ci).

 3) Choisissez Texte dans la liste déroulante située sous le titre de la section Format numérique.
Le formatage est immédiatement appliqué à la cellule.

Remarque

Par défaut, tout nombre mis en forme comme texte dans un classeur sera traité comme le 
nombre zéro par toutes les formules utilisées. Les fonctions ignorent les entrées textuelles 
dans les formules.

Cette fonctionnalité peut être changée dans la boîte de dialogue Options (Outils > Options 
dans la barre de menu), à la page LibreOffice Calc – Formule en cochant Personnalisé 
(conversion de texte en nombres, et autres) dans la section Paramètres de calcul détaillés
puis en sélectionnant le traitement approprié dans la boîte de dialogue Paramètres de calcul
détaillés qui s’ouvre en cliquant sur le bouton Détails
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Saisir des textes

Cliquez dans la cellule et tapez le texte. Les textes sont alignés à gauche par défaut. Une cellule 
peut contenir plusieurs lignes de texte. Si vous voulez insérer des retours à la ligne, appuyez sur 
Ctrl+Entrée pour créer un nouveau paragraphe.

Vous pouvez agrandir la zone de saisie en cliquant sur le bouton Étendre la barre Formule  si-
tué à l’extrémité droite de cette zone. Elle offre alors plusieurs lignes (Figure 21). Cliquez à nou-
veau sur le bouton  pour revenir à la zone de saisie initiale.

Figure 21 : Zone de saisie multi-ligne

Saisir des dates et des heures

Sélectionnez la cellule et tapez la date ou l’heure.

Vous pouvez séparer les éléments de la date avec une barre oblique (/) ou un tiret (–) ou utiliser un
texte comme 10 octobre 2020. Calc reconnaît plusieurs formats de date ; le format utilisé par Calc 
s’appliquera automatiquement.

Vous pouvez séparer les éléments de l’heure avec des deux-points comme 10:43:45. Le format 
horaire utilisé par Calc s’appliquera automatiquement.

Pour modifier le format de date ou d’heure utilisé par Calc, 

 1) La cellule étant active, ouvrez la boîte de dialogue Formatage des cellules (Figure 19) en fai-
sant un clic droit dans la cellule et sélectionnez Formater des cellules dans le menu contex-
tuel, en sélectionnant Format > Cellules dans la barre de menu, en utilisant le raccourci 
Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres est sélectionné puis choisissez Date ou Heure dans la liste 
Catégorie.

 3) Choisissez le format que vous désirez utiliser dans la liste Format. Cliquez sur OK.

Placer des champs dans des cellules

Il est possible d’insérer dans une cellule un champ lié à la date, le nom de la feuille ou celui du do-
cument.

 1) Sélectionnez la cellule et faites un double-clic pour activer le mode d’édition.

 2) Faites un clic droit et choisissez Insérer un champ > Date ou Nom de la feuille ou Titre du 
document dans le menu contextuel.
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Remarque

La commande Insérer un champ > Titre du document insère le nom du classeur et non le 
titre défini dans la page Description de la boîte de dialogue Propriétés du fichier.

Conseil

Les champs sont mis à jour quand le classeur est enregistré ou recalculé quand on appuie 
sur Ctrl+Maj+F9.

Autocorrection

Calc applique automatiquement plusieurs changements durant la saisie de données, à moins que 
vous n’ayez désactivé cette fonction. Vous pouvez également annuler immédiatement chaque 
changement automatique avec Ctrl+Z ou en revenant manuellement à la modification pour rem-
placer l’autocorrection par ce que vous désirez voir vraiment.

Pour modifier les options d’autocorrections, sélectionnez Outils > Options d’AutoCorrection 
dans la barre de menu pour ouvrir la boîte de dialogue AutoCorrection (Figure 22).

Figure 22 : La boîte de dialogue AutoCorrection

Onglet Remplacer
Éditez la table de remplacement pour la correction automatique ou le remplacement de mots
ou d’abréviations dans votre document.
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Onglet Exceptions
Précisez les abréviations ou combinaisons de lettres que vous ne voulez pas que LibreOffice
corrige automatiquement.

Onglet Options
Sélectionnez les options pour la correction des erreurs en cours de frappe.

Onglet Options linguistiques
Spécifiez les options d’autocorrection des guillemets et d’autres options particulières à la 
langue utilisée pour les textes.

Bouton Réinitialiser
En cliquant sur ce bouton, vous rétablissez les valeurs par défaut définies par LibreOffice.

! Attention

Les options d’autocorrection sont communes à tous les modules : les modifier dans Calc, les
modifiera aussi dans Writer ou Impress par exemple.

Désactiver les modifications automatiques

Certains réglages de l’autocorrection sont appliqués quand vous appuyez sur la barre d’espace 
après avoir saisi les données. Pour activer ou désactiver l’autocorrection dans Calc, dans le menu 
Outils, sélectionnez ou non AutoSaisie. Voir aussi « Utiliser l’autosaisie » ci-dessous.

Accélérer la saisie des données

La saisie de données dans un classeur peut demander beaucoup de travail, mais Calc fournit plu-
sieurs outils pour en alléger certaines corvées.

La fonctionnalité la plus simple est de faire glisser et déposer le contenu d’une cellule dans une 
autre avec la souris. Beaucoup de personnes trouvent également utile l’autosaisie. Calc recèle 
également plusieurs autres outils pour la saisie automatique, plus particulièrement pour les conte-
nus répétitifs. Ce sont l’outil Remplir, les listes de sélection et la possibilité de saisir de l’informa-
tion dans plusieurs feuilles du document.

Utiliser l’autosaisie

L’outil AutoSaisie de Calc complète automatiquement des saisies en s’appuyant sur le contenu 
d’autres cellules de la même colonne. Quand le texte est mis en valeur dans la cellule, l’autosaisie 
peut être utilisée de la façon suivante :

• pour accepter la proposition, appuyez sur Entrée ou F2, ou cliquez avec la souris ;

• pour voir d’autres propositions, utilisez les combinaisons de touche Ctrl+Tab pour les faire 
défiler vers l’avant et Maj+Ctrl+Tab pour les faire défiler vers l’arrière ;

• pour voir une liste de tous les éléments de texte disponibles pour l’autosaisie dans la co-
lonne courante, utilisez la combinaison de touche Alt+Bas (↓).

Quand vous tapez des formules qui utilisent des caractères correspondants à des saisies précé-
dentes, une infobulle apparaît avec la liste des dix dernières fonctions utilisées dans l’assistant 
Fonction à partir de tous les noms de plages définis et du contenu de toutes les plages d’éti-
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quettes. L’autosaisie ne distingue pas les majuscules des minuscules dans les données que vous 
saisissez.

L’autosaisie est active par défaut. Pour la désactiver, affichez ou enlevez la coche devant Outils > 
AutoSaisie.

Utiliser l’outil Remplir dans les cellules

L’outil Remplir de Calc permet de dupliquer le contenu existant ou de créer une suite dans une 
suite de cellules de votre classeur.

 1) Sélectionnez la cellule qui contient ce que vous désirez copier ou l’amorce de la série.

 2) Tirez la souris dans n’importe quelle direction ou appuyez sur la touche Maj et cliquez sur la 
dernière cellule que vous voulez remplir.

 3) Sélectionnez Feuille > Remplir les cellules dans la barre de menu puis la direction dans la-
quelle vous voulez copier ou créer les données : Remplir vers le bas, vers la droite, vers 
le haut, vers la gauche, Remplir la série, ou Remplir de Nombres aléatoires dans le 
sous-menu.

Vous pouvez aussi utiliser un raccourci pour remplir les cellules (Figure 23).

 1) Sélectionnez la cellule qui contient ce que vous désirez copier ou l’amorce de la série.

 2) Déplacez le pointeur sur le petit carré en bas à droite de la cellule sélectionnée. Le pointeur 
change de forme.

 3) Cliquez et tirez dans la direction où vous désirez remplir les cellules. Si la cellule initiale 
contenait du texte, celui-ci sera automatiquement recopié. Si la cellule initiale contenait un 
nombre (seul ou en fin de chaîne), une suite croissante sera créée si vous tirez vers la droite
ou vers le bas, décroissante si vous tirez vers la gauche ou vers le haut.

 4) Si la cellule initiale contient un nombre et que vous appuyez simultanément sur la touche 
Ctrl, son contenu est recopié au lieu d’être incrémenté ou décrémenté.

Figure 23 : Utiliser l’outil Remplir

Utiliser des séries de remplissage

Quand vous choisissez Feuille > Remplir les cellules > Remplir la série dans la barre de menu, 
la boîte de dialogue Remplir la série s’ouvre (Figure 24). Vous pouvez y sélectionner le type de sé-
rie que vous voulez.
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Figure 24 : La boîte de dialogue Remplir la série

Définir une liste de remplissage

Si vous choisissez l’option Remplir automatiquement dans la boîte de dialogue Remplir la série (Fi-
gure 24), saisissez un texte dans le champ Valeur initiale et appuyez sur OK. Calc va rechercher 
ce texte parmi vos listes de tri prédéfinies et, s’il le trouve, remplir les cellules sélectionnées avec 
les éléments de cette liste. Sélectionnez Outils > Options dans la barre de menu pour ouvrir la 
boîte de dialogue Options, puis ouvrez la page LibreOffice Calc – Listes de tri (Figure 25) pour voir
les listes de tri actuellement définies.

Figure 25 : La boîte de dialogue Listes de tri

Pour définir vos propres listes de remplissage :

 1) Sélectionnez Outils > Options dans la barre de menu pour ouvrir la boîte de dialogue Op-
tions (voir ci-dessus). Celle-ci affiche les suites précédemment définies dans la zone Listes à
gauche et le contenu de la liste sélectionnée dans la zone Entrées.

 2) Cliquez sur Nouveau et la boîte Entrées se vide.
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 3) Tapez la suite de la nouvelle liste dans la boîte Entrées (une valeur par ligne).

 4) Cliquez sur Ajouter et la nouvelle liste apparaît désormais dans la zone Listes.

 5) Cliquez sur OK pour enregistrer la nouvelle liste.

Utiliser les listes de sélection

Les listes de sélection sont disponibles uniquement pour des textes qui ont été déjà saisis dans la 
même colonne.

 1) Sélectionnez une cellule vide dans une colonne contenant déjà des entrées textuelles.

 2) Appuyez sur Alt+↓ (flèche vers le bas) ou faites un clic droit et choisissez Liste de sélec-
tion dans le menu contextuel. Une liste déroulante apparaît et propose le contenu de toutes 
les cellules de la même colonne qui ont au moins un caractère de texte ou dont le format est 
défini comme texte. Ces textes sont triés par ordre alphabétique et ceux qui ont des occur-
rences multiples n’apparaissent qu’une seule fois.

 3) Cliquez sur l’entrée dont vous avez besoin pour que le texte s’insère dans la cellule sélec-
tionnée.

Partager du contenu entre plusieurs feuilles

Il peut arriver que vous vouliez saisir la même information dans la même cellule de plusieurs 
feuilles, par exemple pour fixer des listes standard pour un groupe de personnes ou pour des orga-
nismes. Au lieu de saisir la liste individuellement dans chaque feuille, vous pouvez la saisir en une 
fois pour toutes les feuilles. Pour cela,

 1) Choisissez Édition > Sélectionner > Sélectionner les feuilles  dans la barre de menu pour
ouvrir la boîte de dialogue Sélectionner des feuilles.

 2) Sélectionnez les feuilles où vous désirez que l’information soit répétée. Utilisez les touches 
Maj et Ctrl (Options sur Mac) pour sélectionner plusieurs feuilles.

 3) Cliquez sur OK pour sélectionner les feuilles dont les onglets changent de couleur.

 4) Saisissez les informations dans la première feuille où vous souhaitez les voir apparaître, 
elles seront répétées dans toutes les feuilles sélectionnées.

! Attention

Cette technique écrase, sans aucun avertissement, toute information qui se trouve déjà 
dans les cellules des autres feuilles sélectionnées. Pour cette raison, quand vous avez fini, 
assurez-vous de bien désélectionner toutes les feuilles sauf celle que vous voulez modifier. 
(Ctrl+clic sur un onglet pour sélectionner ou désélectionner la feuille.)

Valider le contenu des cellules

Quand vous créez des classeurs destinés à être utilisés par d’autres personnes, vous désirez 
peut-être vous assurer qu’elles saisissent des données correctes ou appropriées à la cellule. Vous 
pouvez également utiliser la validation pour votre propre usage comme guide pour saisir des don-
nées complexes ou rarement utilisées.
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Les séries de remplissage et les listes de sélection peuvent convenir pour certains types de don-
nées, mais elles sont limitées à des informations prédéfinies. Pour valider une nouvelle donnée 
saisie par un utilisateur, sélectionnez une cellule et choisissez Données > Validité dans la barre 
de menu pour définir le type de contenu qui peut être saisi dans cette cellule. Par exemple, une 
cellule peut recevoir uniquement une date ou un nombre entier, sans caractère alphabétique ni sé-
parateur décimal ; ou bien encore une cellule ne doit pas être laissée vide.

Selon les paramètres choisis pour la validation, l’outil peut aussi définir l’intervalle des valeurs qui 
peuvent être saisies, et fournir des messages d’aide qui expliquent les règles de validation que 
vous avez paramétrées pour cette cellule (ce que les utilisateurs devraient faire s’ils saisissent un 
contenu incorrect). Vous pouvez aussi paramétrer la cellule pour refuser un contenu incorrect, l’ac-
cepter avec un avertissement, ou exécuter une macro si une valeur erronée est saisie.

Pour plus d’informations sur cette fonctionnalité, voir le chapitre 2, Saisir, éditer et formater des 
données dans le Guide Calc.

Modifier les données

Supprimer les données d’une cellule

Supprimer seulement les données

Les données seules peuvent être supprimées dans une cellule sans en affecter le formatage. Cli-
quez dans la cellule pour la sélectionner et appuyez ensuite sur la touche Suppr.

Pour supprimer totalement des cellules, des lignes ou des colonnes, voir « Supprimer des co-
lonnes et des lignes », page 16, et « Supprimer des cellules », page 16.

Supprimer les données et le formatage

Les données et le formatage peuvent être supprimés d’une cellule en une seule fois.

 1) Cliquez sur la cellule pour la sélectionner.

 2) Appuyez sur la touche Retour arrière, faites un clic droit et choisissez Effacer le conte-
nu dans le menu contextuel ou sélectionnez Feuille > Effacer des cellules dans la barre de
menu.

Figure 26 : La boîte de dialogue Supprimer du contenu

 3) Dans la boîte de dialogue Supprimer du contenu (Figure 26) choisissez parmi les options ou 
cochez Tout Supprimer.
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 4) Cliquez sur OK.

Remplacer toutes les données dans une cellule

Pour supprimer les données et insérer de nouvelles données, tapez simplement par-dessus les 
anciennes données. Les nouvelles données conserveront le format des précédentes.

Vous pouvez aussi cliquer dans la ligne de saisie de la barre de formule (Figure 1 page 2), puis 
faire un double-clic sur les données pour les sélectionner totalement avant de taper les nouvelles 
données.

Modifier les données dans une cellule

Il est parfois nécessaire de changer le contenu d’une cellule sans en supprimer tout le contenu, 
par exemple quand la phrase « Ventes du 2e trimestre » se trouve dans une cellule et doit être 
changée en « Ventes de fleurs du 2e trimestre ». 

Avec le clavier

Si vous avez l’intention d’utiliser le clavier pour modifier les données des cellules en utilisant la 
souris au minimum, vous pouvez activer l’option Appuyer sur Entrée pour basculer en mode Édi-
tion dans la page LibreOffice – Général de la boîte de dialogue Options (Outils > Options). Sinon,
vous pouvez toujours appuyer sur la touche F2 pour faire passer la cellule en mode édition.

 1) Cliquez dans la cellule désirée pour la sélectionner.

 2) Appuyez sur la touche F2 et le curseur sera placé à la fin de la cellule.

 3) Utilisez alors les flèches du clavier pour déplacer le curseur dans le texte de la cellule à la 
position où débute la modification. Appuyez sur la touche Suppr ou la touche Retour 
Arrière pour supprimer les données non désirées avant de saisir les nouvelles.

 4) Appuyez sur la touche Entrée quand vous avez terminé pour enregistrer vos modifications.

Avec la souris

 1) Faites un double-clic dans la cellule voulue pour la sélectionner et placer le curseur à l’inté-
rieur pour les modifications. Vous pouvez aussi sélectionner Édition > Mode édition de cel-
lule dans la barre de menu pour placer la cellule en mode d’édition.

 2) Continuez d’une des deux façons suivantes :

– positionnez le curseur à l’endroit où vous voulez saisir les nouvelles données dans la cel-
lule ;

– faites un clic unique dans la cellule puis déplacez le curseur dans la ligne de saisie de la 
barre de formule et cliquez à l’endroit où vous voulez saisir les nouvelles données dans la
cellule.

 3) Quand vous avez terminé, cliquez hors de la cellule pour la désactiver et enregistrer vos mo-
difications.

La fonction Collage spécial

Pour coller du texte, des nombres ou des formules dans une cellule ou une plage de cellules cible :

 1) Sélectionnez la cellule ou la plage de cellules source et copier les données.
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 2) Sélectionnez la cellule ou la plage de cellules cible.

 3) Faites un clic droit sur celle-ci et choisissez Collage spécial dans le menu contextuel puis 
Texte non formaté, Texte, Nombre ou Formule.

Vous pouvez aussi utiliser Édition > Collage spécial dans la barre de menu.

La fonction Collage spécial vous permet aussi de coller dans une cellule ou une plage de cellules 
des éléments choisis des données contenues dans une autre, par exemple son format ou le résul-
tat de sa formule. Pour cela :

 1) Sélectionnez la cellule ou la plage de cellules source et copier les données.

 2) Sélectionnez la cellule ou la plage de cellules cible.

 3) Choisissez Édition > Collage spécial > Collage spécial dans la barre de menu ou Collage 
spécial > Collage spécial dans le menu contextuel, ou appuyez sur Ctrl+Maj+V pour ou-
vrir la boîte de dialogue Collage spécial (Figure 27).

 4) Faites votre choix parmi les options des sections Sélection, Opérations, Options et Dépla-
cer les cellules.

 5) Cliquez sur OK pour coller les données choisies dans la cellule ou la plage de cellules sélec-
tionnée et refermer la boîte de dialogue.

Figure 27 : la boîte de dialogue Collage spécial

Formater les données

Remarque

Tous les paramétrages abordés dans cette section peuvent aussi être affectés à un style de 
cellule. Voir le chapitre 4, Utiliser les styles et les modèles, du Guide Calc pour plus d’infor-
mations.
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Disposer le texte sur plusieurs lignes

Plusieurs lignes de texte peuvent être saisies dans une seule cellule en utilisant le renvoi à la ligne
automatique ou des retours manuels à la ligne. Chaque méthode est utile dans différentes situa-
tions.

Utiliser le retour à la ligne automatique

Pour que le texte revienne à la ligne en fin de cellule, utilisez une des méthodes suivantes

Méthode 1

 1) La cellule étant active, ouvrez la boîte de dialogue Formatage des cellules en faisant un clic 
droit dans la cellule avant de sélectionner Formater des cellules dans le menu contextuel, 
en sélectionnant Format > Cellules dans la barre de menu ou en utilisant le raccourci Ctrl+1
au clavier.

 2) Cliquez sur l’onglet Alignement (Figure 28), dans la section Propriétés, cochez l’option Ren-
voi à la ligne automatique et cliquez sur OK.

Figure 28 : L’onglet Alignement de la boîte de dialogue Formatage des cellules.

Méthode 2

 1) Sélectionnez la cellule.

 2) Dans le volet latéral, ouvrez l’onglet Propriétés puis la section Alignement.

 3) Cochez Ajuster le texte pour appliquer immédiatement le formatage.
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Figure 29 : Formatage du retour à la ligne.

Utiliser les sauts de ligne manuels

Pour insérer un saut de ligne manuel pendant la frappe dans une cellule, appuyez sur 
Ctrl+Entrée. Pour insérer un saut de ligne dans un texte déjà saisi, faites un double-clic dans la
cellule, positionnez le curseur à l’endroit où vous voulez faire un saut de ligne avant d’appuyer sur 
Ctrl+Entrée. Dans la ligne de saisie, vous pouvez aussi appuyer sur Maj+Entrée.

Quand un saut de ligne est saisi dans une cellule, la hauteur de la ligne de la cellule est adaptée, 
mais sa largeur ne change pas et le texte chevauche toujours la fin de la cellule. Vous devez modi-
fier manuellement la largeur de la cellule ou repositionner votre saut de ligne.

Ajuster le texte à la taille de la cellule

La taille de police des données d’une cellule peut être automatiquement ajustée pour remplir la 
cellule. Pour cela, cochez l’option Ajuster à la taille de la cellule dans la boîte de dialogue Forma-
tage des cellules (Figure 28) dans la section Propriétés de l’onglet Alignement.

Fusionner des cellules

Il est possible de fusionner des cellules contiguës en une seule cellule.

 1) Sélectionnez la plage de cellules contiguës que vous souhaitez fusionner.

 2) Faites un clic droit sur la sélection et choisissez Fusionner les cellules dans le menu 
contextuel ; vous pouvez aussi sélectionner Format > Fusionner les cellules > Fusionner 
les cellules ou Fusionner et centrer les cellules dans la barre de menu ou cliquer sur le 
bouton Fusionner et centrer les cellules  dans la barre d’outils Formatage. La com-
mande Fusionner et centrer les cellules centre le contenu final dans la cellule obtenue par 
fusion.

 3) Si les cellules contiennent des données, une boîte de dialogue (Figure 30) s’ouvre pour vous
demander comment traiter le contenu des cellules fusionnées. Faites votre choix et cliquez 
sur OK.
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Figure 30 : choix du traitement du contenu des cellules fusionnées.

! Attention

La fusion de cellules peut provoquer des erreurs de calcul dans les formules utilisées dans 
le classeur.

Scinder les cellules

Il n’est possible de scinder que des cellules qui ont été obtenues par fusion de plusieurs cellules.

 1) Sélectionnez une cellule fusionnée.

 2) Choisissez Format > Fusionner les cellules > Scinder les cellules dans la barre de menu,
faites un clic droit et choisissez Scinder les cellules dans le menu contextuel ou cliquez sur 
le bouton Fusionner et centrer les cellules  de la barre d’outils Formatage.

 3) Les données dans la cellule restent dans la première cellule obtenue. Si les cellules mas-
quées contenaient des données avant la fusion, vous devrez les replacer manuellement 
dans les bonnes cellules.

Formater les nombres

Plusieurs formats de nombres différents peuvent être appliqués aux cellules en utilisant les icônes 
de la barre d’outils Formatage. Sélectionnez la cellule, puis cliquez sur l’icône correspondante.

Pour plus de contrôle ou pour sélectionner d’autres formats de nombres, utilisez l’onglet Nombres 
de la boîte de dialogue Formatage des cellules (Figure 19  page 23):

• appliquez aux données l’un des types de la liste Catégorie ;

• paramétrez le nombre de décimales et de zéros non significatifs dans Options ;

• saisissez une description du format personnalisée ;

le champ Langue détermine les paramètres locaux pour les différents formats comme l’ordre dans
les dates et le symbole de l’unité monétaire. Certains formats numériques sont accessibles depuis 
la section Formats numériques de l’onglet Propriétés du volet latéral. Cliquez sur le bouton Plus 
d’options  pour ouvrir la boîte de dialogue Formatage des cellules.
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Formater les polices et le texte des cellules

Conseil

Pour l’homogénéité du classeur, utilisez des styles de cellule chaque fois que possible.

Pour choisir rapidement la police utilisée dans une cellule :

 1) Sélectionnez la cellule ou la plage de cellules.

 2) Cliquez sur la flèche à droite du champ Nom de police à gauche de la barre d’outils Forma-
tage, ou dans la section Caractère de l’onglet Propriétés du volet latéral, et choisissez une 
police dans la liste.

 3) Pour choisir la taille de la police, cliquez sur la flèche à droite du champ Taille de police dans 
la barre d’outils Formatage, ou dans la section Caractère de l’onglet Propriétés du volet laté-
ral, et choisissez une taille dans la liste.

 4) Pour changer d’autres attributs, vous pouvez utiliser les boutons Gras (  ou ), Italique (
) ou Soulignage ( ) de la barre d’outils Formatage ou de la section Caractère de l’on-

glet Propriétés du volet latéral.

 5) Pour modifier l’alignement horizontal du paragraphe, cliquez sur un des quatre boutons d’ali-
gnement (Gauche , Centré , Droite , Justifié ) de la barre d’outils Formatage ou 
de la section Alignement de l’onglet Propriétés du volet latéral. Vous trouverez des choix 
supplémentaires dans l’onglet Alignement la boîte de dialogue Formatage des cellules 
(menu Format > Cellule ou raccourci Ctrl+1) (Figure 28 page 34) en déroulant la liste Ho-
rizontal de la section Alignement du texte.

 6) Pour modifier l’alignement vertical du texte dans la cellule, ouvrez l’onglet Alignement la 
boîte de dialogue Formatage des cellules (menu Format > Cellule ou raccourci Ctrl+1) (Fi-
gure 28 page 34) et sélectionnez une option dans la liste déroulante Vertical de la section 
Alignement du texte.

 7) Pour choisir une couleur de police, cliquez sur la flèche à droite de l’icône Couleur de police
 dans la barre d’outils Formatage, ou dans la section Caractère de l’onglet Propriétés du 

volet latéral. Cliquez sur la couleur voulue dans la palette Couleur de police qui s’ouvre alors.

 8) Pour spécifier la langue utilisée dans la cellule, utilisez l’onglet Police de la boîte de dialogue 
Formatage des cellules.

 9) Utilisez l’onglet Effets de caractère de la boîte de dialogue Formatage des cellules pour défi-
nir les autres caractéristiques de la police

Formater les bordures des cellules

Pour formater les bordures d’une cellule ou d’un groupe de cellules sélectionnées, cliquez sur 
l’icône Bordures  de la barre d’outils Formatage et choisissez une des options proposées par la
palette.

Pour choisir rapidement un style de ligne et une couleur pour les bordures d’une cellule, cliquez 
sur la petite flèche près des icônes Style de bordure  et Couleur de bordure  dans la barre 
d’outils Formatage pour afficher une palette Style de bordure ou Couleur de bordure.

Formater les données | 37



La section Apparence de cellule dans l’onglet Propriétés du volet latéral contient les contrôles 
Bordures de cellule, Style de ligne et Couleur de ligne.

Pour des contrôles supplémentaires, comme l’espacement entre les bordures de la cellule et le 
texte, utilisez l’onglet Bordures de la boîte de dialogue Formatage des cellules. Vous pouvez éga-
lement y définir un style d’ombre. Cliquer sur le bouton Plus d’options  de la barre de titre Ap-
parence de cellule ou sur Plus d’options dans la liste déroulante style de ligne de cette section, 
ouvre l’onglet Bordures de la boîte de dialogue Formatage des cellules.

Voir le chapitre 4 du Guide Calc, Utiliser les styles et les modèles dans Calc, pour plus de détails.

Remarque

Les propriétés de bordure de cellule s’appliquent à une cellule, et ne peuvent être modifiées 
que dans cette cellule. Par exemple, si la cellule C3 a une bordure haute (ce qui est visuelle-
ment équivalent à une bordure basse dans C2), cette bordure ne pourra être supprimée 
qu’en sélectionnant C3. Elle ne pourra pas être supprimée dans C2.

Formater l’arrière-plan des cellules

Pour choisir rapidement une couleur d’arrière-plan pour une cellule ou d’un groupe de cellules, cli-
quez sur la petite flèche près de l’icône Couleur d’arrière-plan dans la barre d’outils Forma-
tage. Une palette de choix de couleurs, identique à la palette Couleur de police, s’affiche. Vous 
pouvez également utiliser l’onglet Arrière-plan de la boîte de dialogue Formatage des cellules. La 
section Apparence de cellule dans l’onglet Propriétés du volet latéral contient un contrôle Ar-
rière-plan de cellule avec une palette de couleurs.

Voir le chapitre 4 du Guide Calc, Utiliser les styles et les modèles dans Calc, pour plus de détails.

Appliquer un style aux cellules

Pour appliquer un style à une cellule ou à un groupe de cellules, utilisez le menu Styles qui pro-
pose des styles prédéfinis. Ceux-ci peuvent aussi être appliqués ou modifiés par l’intermédiaire de 
l’onglet Styles et formatage du volet latéral. Vous pouvez créer de nouveaux styles en sélection-
nant Styles > Nouveau style à partir de la sélection dans la barre de menu ou en cliquant sur le 
bouton Nouveau style à partir de la sélection ( ) en haut de l’onglet Styles et formatage. Sai-
sissez un nouveau nom pour votre style ou cliquez sur un nom de style existant pour le mettre à 
jour. Vous pourrez par la suite modifier ou effacer vos styles personnalisés grâce au menu contex-
tuel de l’onglet Styles et formatage.

Formatage automatique des cellules

Avec l’autoformat

Vous pouvez utiliser la fonction AutoFormat de Calc pour mettre en forme rapidement et facilement
un tableau (groupe de cellules). Elle vous permet aussi de donner très facilement le même aspect 
à différentes plages de la feuille. Toutes les mises en forme appliquées le sont par formatage di-
rect.

 1) Sélectionnez les cellules que vous voulez formater dans au moins trois colonnes et trois 
lignes, y compris les en-têtes de colonnes et de lignes.
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 2) Sélectionnez Format > Styles d’AutoFormat dans la barre de menu pour ouvrir la boîte de 
dialogue AutoFormat (Figure 31).

 3) Choisissez le type et la couleur de formatage dans la liste.

 4) Sélectionnez les propriétés de formatage à inclure dans le style d’autoformat. La boîte de 
dialogue affiche immédiatement les effets des options que vous cochez ou décochez.

 5) Cliquez sur OK.

Figure 31 : La boîte de dialogue AutoFormat

Définir un nouvel autoformat

Vous pouvez définir un nouvel autoformat qui sera disponible pour tous les classeurs.

 1) Mettez en forme le type de données, la police, sa taille, les bordures, l’arrière-plan, etc. d’une
plage d’au moins 4 cellules sur 4 puis sélectionnez-la.

 2) Sélectionnez Format > Styles d’AutoFormat dans la barre de menu pour ouvrir la boîte de 
dialogue AutoFormat où le bouton Ajouter est maintenant actif.

 3) Cliquez sur Ajouter.

 4) Dans la zone Nom de la boîte de dialogue Ajouter un AutoFormat qui s’ouvre alors, tapez un
nom significatif pour le nouveau format.

 5) Cliquez sur OK pour l’enregistrer. Le nouvel autoformat est maintenant disponible dans la 
liste Format de la boîte de dialogue AutoFormat.

Remarque

Le nouvel autoformat est stocké sur votre ordinateur, dans votre profil utilisateur, et n’est 
donc pas accessible à d’autres utilisateurs. Ceux-ci peuvent cependant l’importer en sélec-
tionnant la plage dans le document et en l’utilisant pour définir un nouvel autoformat.
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Utiliser les thèmes

Calc offre un ensemble prédéfini de thèmes de formatage (ensembles de styles) que vous pouvez 
appliquer aux classeurs. Il n’est pas possible d’ajouter de nouveaux thèmes à Calc ni de les modi-
fier. Vous pouvez toutefois modifier les styles d’un thème après l’avoir appliqué à un classeur. Ces 
styles modifiés ne seront disponibles que dans celui-ci quand vous l’enregistrerez.

Pour appliquer un thème à un classeur :

 1) Sélectionnez Format > Thème pour classeur dans la barre de menu ou cliquez sur l’icône 
Thème pour classeur  dans la barre d’outils Outils. La boîte de dialogue Sélection de 
thème s’ouvre (Figure 32). Elle donne la liste des thèmes applicables à l’ensemble du clas-
seur.

 2) Choisissez le thème que vous désirez appliquer. Dès votre choix effectué, les styles du 
thème sont appliqués au classeur et immédiatement visibles.

 3) Cliquez sur OK.

 4) Si vous le souhaitez, vous pouvez utiliser l’onglet Styles et formatage du volet latéral pour 
modifier certains styles. Ces changements n’affecteront pas le thème et ils ne s’appliqueront 
qu’au classeur sur lequel vous travaillez. Pour plus d’informations sur la modification des 
styles, voir le chapitre 3, Utiliser les styles et les modèles.

! Attention

Si vous appliquez un deuxième thème après un premier, les modifications des styles du pre-
mier thème seront supprimées au profit des styles du second thème.

Figure 32 : La boîte de dialogue Sélection de thème
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Utiliser le formatage conditionnel

Vous pouvez paramétrer le formatage des cellules pour qu’il change selon les conditions que vous 
spécifiez. Par exemple, dans un tableau de nombres, vous pouvez afficher toutes les valeurs au-
dessus de la moyenne en vert et celles en dessous de la moyenne en rouge. Plusieurs options de 
mise en forme peuvent être saisies et disposées dans un ordre de priorité qui permet à certaines 
options de formatage de prendre place avant les autres.

Le formatage conditionnel repose sur l’utilisation de styles et, pour l’appliquer, Calculer automati-
quement doit être activé. Cochez Données > Calculer > Calculer automatiquement. Voir le cha-
pitre 2 Saisir, modifier et formater des données du Guide Calc pour plus d’informations sur le for-
matage conditionnel.

Masquer et afficher les données

Quand des éléments sont masqués, ils ne sont ni visibles ni imprimables, mais ils peuvent toujours
être sélectionnés pour une copie si vous sélectionnez les éléments autour d’eux. Par exemple, si 
la colonne B est masquée, elle est copiée si vous sélectionnez les colonnes A et C. Quand vous 
avez à nouveau besoin d’un élément masqué, vous pouvez inverser le processus et afficher l’élé-
ment.

Pour plus d’informations sur la façon de masquer/afficher des données, en particulier pour utiliser 
les outils Plans et groupes, ou le filtrage de données, voir le chapitre 2, Saisir, modifier et formater 
des données du Guide Calc.

Filtrer les données

Un filtre est une liste de conditions qu’une entrée doit remplir pour être affichée. Calc offre trois 
types de filtres.

• Standard : ce filtre permet de définir les conditions logiques pour filtrer les données.

• Autofiltre : les données sont filtrées selon une valeur ou une chaîne précise. L’autofiltre crée
automatiquement des listes des valeurs contenues dans chaque colonne de la plage où vous
pouvez choisir les éléments que vous voulez afficher.

• Spécial : ce filtre utilise les données de cellules spécifiées comme critères de filtrage.

Le paramétrage et l’utilisation des filtres sont présentés au chapitre 2, Saisir, modifier et formater 
des données du Guide Calc.

Protection des cellules

Toutes ou certaines cellules d’un classeur peuvent être protégées par un mot de passe contre des 
modifications apportées par un utilisateur non autorisé. Cela peut être utile quand plusieurs per-
sonnes ont accès au classeur, mais que, pour diverses raisons, seules quelques-unes sont autori-
sées à en modifier les données. Il est aussi possible de masquer les cellules protégées.

Utilisez l’onglet Protection de cellule de la boîte de dialogue Formatage des cellules (Figure 33) 
pour paramétrer la protection des cellules et définir l’état de masquage des cellules protégées.
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Figure 33 : L’onglet Protection de cellule de la boîte de dialogue Formatage des cellules.

Quand toutes les cellules ont reçu un état protégé ou non protégé :

 1) Sélectionnez Protéger la feuille dans le menu Outils ou dans le menu contextuel ouvert par
un clic droit sur l’onglet de la feuille.

 2) Dans la boîte de dialogue Protéger la feuille (Figure 34), cochez l’option Protéger cette 
feuille et le contenu des cellules verrouillées.

 3) Saisissez un mot de passe et confirmez-le.

 4) Cochez ou décochez les options de sélection des cellules par l’utilisateur.

 5) Cliquez sur OK.

À partir de ce moment, toute cellule qui a reçu l’état protégé ne pourra plus être modifiée sans mot 
de passe saisi au préalable.

Figure 34 ; la boîte de dialogue Protéger la feuille.

Les onglets des feuilles protégées sont marqués par l’icône d’un verrou comme on le voit sur la Fi-
gure 35.

Figure 35 : La feuille 2 est protégée (verrouillée).

Au lieu de protéger des cellules une par une dans certaines feuilles, vous pouvez aussi choisir de 
protéger la totalité du classeur en sélectionnant Outils > Protéger la structure de la feuille de 
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calcul dans la barre de menu. Cette option vous permet de protéger votre classeur contre l’ajout, 
la suppression, de déplacement ou le changement de nom des feuilles. Vous pouvez aussi saisir 
un mot de passe dans la boîte de dialogue Protéger la structure de la feuille de calcul.

Trier des enregistrements

Le tri modifie la disposition des cellules dans la feuille selon les critères que vous avez choisis. 
Dans Calc, vous pouvez utiliser simultanément plusieurs critères de tri, qui sont appliqués l’un 
après l’autre. Les tris sont pratiques quand vous cherchez un élément particulier, et sont encore 
plus puissants combinés aux filtres.

De plus, le tri est souvent utile quand vous ajoutez de nouvelles données. Quand une liste est 
longue, il est habituellement plus facile d’ajouter des données en bas de la feuille, plutôt que d’in-
sérer des lignes à leur bonne place. Après avoir ajouté des données, vous pouvez les trier pour 
mettre à jour la feuille.

Pour plus d’informations sur les options de tri, voir le chapitre 2, Entrer, modifier et formater des 
données du Guide Calc.

Pour trier les cellules de votre classeur :

 1) Sélectionnez les cellules à trier.

 2) Sélectionnez Données > Trier dans la barre de menu ou cliquez sur le bouton Trier  de la
barre d’outils Standard pour ouvrir la boîte de dialogue Trier (Figure 36).

 3) Sélectionnez les critères de tri dans les listes déroulantes. Celles-ci sont remplies à partir 
des cellules sélectionnées.

 4) Cochez soit un tri croissant (1-9, A-Z) soit un tri décroissant (Z-A, 9-1).

 5) Ajustez les paramètres de l’onglet Options à vos besoins.

 6) Cliquez sur OK pour que le tri soit effectué sur la feuille de calcul.

Figure 36 : La boîte de dialogue Critères de tri
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Commentaires de cellules

Les commentaires sont de petites notes qui peuvent servir de rappels ou de compléments d’infor-
mation pour l’utilisateur. Un commentaire n’est pas considéré comme une partie du classeur quand
il s’agit de calcul ou d’impression ; il n’apparaîtra que si la souris survole une cellule qui a été 
« commentée ».

La façon la plus simple pour insérer un commentaire consiste à faire un clic droit sur la cellule 
concernée puis à choisir Insérer un commentaire dans le menu contextuel. Vous pouvez aussi 
sélectionner Insertion > Commentaire dans la barre de menu, utiliser le raccourci Ctrl+Alt+C 
ou cliquer sur le bouton Insérer un commentaire ( ) de la barre d’outils Standard.

Par défaut, les commentaires sont masqués et n’apparaissent qu’au moment où la cellule est sur-
volée par la souris. Celles qui possèdent un commentaire sont marquées d’un petit carré rouge 
dans le coin supérieur droit. Pour modifier la visibilité des commentaires, sélectionnez Affichage >
Commentaires dans la barre de menu.

Pour plus d’informations, voir le chapitre 11, Partager et réviser des documents, du Guide Calc.

Utiliser les formules et les fonctions

Vous allez sans doute avoir besoin de plus que du texte et des nombres dans votre feuille de cal-
cul. Souvent le contenu d’une cellule dépend du contenu d’autres cellules. Calc permet de faire 
des calculs, des plus simples aux plus complexes en utilisant des formules. Les formules sont des 
équations qui utilisent des opérateurs, des fonctions, des nombres et des variables pour produire 
un résultat. Les variables sont placées dans des cellules qui contiennent les données nécessaires 
aux équations.

Une fonction est une méthode de calcul prédéfinie que l’on saisit dans une cellule pour aider à 
analyser ou manipuler ses données. Il suffit d’en saisir les arguments et le calcul se fait automati-
quement. Les fonctions vous aident à créer les formules nécessaires pour obtenir les résultats que
vous cherchez.

Créer des formules

Les fonctions et formules peuvent être tapées directement dans la barre de formule ou grâce à 
l’assistant Fonction. Pour ouvrir l’assistant Fonction, cliquez sur l’icône Assistant Fonctions ( ) 
à droite de la zone de nom (Figure 2, page 3), sélectionnez Insertion > Fonction dans la barre de
menu ou appuyez sur Ctrl+F2.

À l’intérieur de cet assistant, vous pouvez rechercher une fonction parmi le grand nombre de celles
qui sont disponibles et en réduire la liste. Vous pouvez aussi compléter la fonction choisie sans 
quitter l’assistant pour ne pas avoir à la saisir dans la barre de formule.

Une fois la formule sélectionnée, l’assistant offre une brève explication de son utilisation et de sa 
syntaxe correcte, ainsi que des boîtes de saisie, où vous pouvez entrer les informations néces-
saires à la fonction, et une boîte de résultat qui vous montrera le résultat correspondant aux don-
nées saisies.
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Figure 37 : L’assistant Fonction avec la boîte de recherche

Remarque

Le volet latéral de Calc offre un onglet Fonctions ( ) comme alternative à l’assistant. Il offre
une liste des fonctions accompagnées d’une brève explication de leur utilisation et de leur 
syntaxe, mais ne propose pas les fonctions de recherche et de saisie des données que l’on 
trouve dans l’assistant.

Référez-vous au chapitre 7, Formules et fonctions, du Guide Calc pour plus d’informations sur les 
formules et l’assistant Fonctions.

Analyser les données

Calc offre plusieurs outils pour vous aider à analyser les informations contenues dans les feuilles 
de calcul, allant des fonctions pour copier et réutiliser les données, à celles permettant de créer 
automatiquement des sous-totaux ou encore à faire varier l’information pour vous aider à trouver 
les réponses que vous cherchez. Ces outils sont partagés entre les menus Données et Outils.

Calc propose aussi de nombreux outils d’analyse statistique des données qui vous permettent 
d’obtenir des informations numériques importantes sur les données provenant de mesures phy-
siques, de sondages ou même de transactions commerciales telles que des ventes, des cotations 
boursières, etc. Ces analyses de données statistiques sont accessibles par le menu Données > 
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Statistiques. Voir le chapitre 9, Analyse de données du Guide Calc pour plus d’informations sur 
les outils proposés par Calc dans ce but.

Voyez le chapitre 9, Analyse des données, du Guide Calc pour plus d’informations sur les outils 
dont dispose Calc pour analyser les données.

Tables et diagrammes dynamiques

L’un des outils les plus utiles pour l’analyse de données est la Table dynamique, un moyen d’orga-
niser, de manipuler et de résumer de grandes quantités de données pour en faciliter la lecture et la
compréhension tout en vous permettant de répondre à différentes questions sur votre classeur en 
réarrangeant les données que vous y avez saisies. Grâce à une table dynamique, vous pouvez ob-
tenir différents résumés de la source de données, afficher les détails des zones d’intérêt et créer 
des rapports. Vous pouvez aussi créer un diagramme dynamique pour obtenir une représentation 
graphique des données de la table dynamique.

Supposons, par exemple, que vous avez un classeur qui contient une liste de dons à diverses 
œuvres de charité obtenue par un groupe de recruteurs sur plusieurs mois, mais que vous ne vous
intéressez qu’à la somme totale collectée par chaque recruteur. Pour répondre à cette question, 
vous pourriez calculer manuellement cette somme grâce aux options de tri et de mise en forme of-
fertes par Calc. Vous pouvez aussi disposer une table dynamique comme sur la Figure 38 pour fa-
ciliter la lecture et l’organisation des données.

Figure 38 : La boîte de dialogue Mise en page de la table dynamique
avec les données brutes et les résultats

Pour ouvrir la boîte de dialogue de création d’une table dynamique, sélectionnez Données > Table
dynamique > Insérer ou éditer dans la barre de menu ou cliquez sur le bouton Insérer ou éditer 
une table dynamique  dans la barre d’outils Standard. Celle-ci va deviner de manière intelli-
gente les en-têtes des colonnes d’après les données brutes fournies pour les insérer dans la boîte 
de sélection des Champs disponibles. À partir de celle-ci, vous pouvez glisser-déposer ceux qui 
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vous intéressent dans les Champs de colonne, de ligne et de données pour organiser la table à 
votre convenance. Cliquez sur OK pour voir le résultat.

Pour choisir de nouvelles informations à afficher ou pour modifier leur disposition, faites un clic 
droit dans la table dynamique pour ouvrir le menu contextuel et sélectionnez Propriétés. Vous 
pouvez aussi ouvrir la même boîte de dialogue en sélectionnant Données > Table dynamique > 
Insérer ou éditer dans la barre de menu ou cliquant sur le bouton Insérer ou éditer une table 
dynamique  dans la barre d’outils Standard.

Référez-vous au chapitre 8, Utiliser la table de pilote, du Guide Calc pour plus d’informations sur 
les tables dynamiques.

Diagrammes de tables dynamiques

Pour obtenir une représentation visuelle des données contenues dans une table dynamique, il est 
possible de créer un diagramme de table dynamique. D’un point de vue fonctionnel, un diagramme
de table dynamique est pratiquement identique à un diagramme ordinaire, sauf dans deux do-
maines importants. D’une part, quand les données de la table dynamique sont modifiées, le dia-
gramme s’ajuste automatiquement pour les refléter. D’autre part, il comporte des boutons de 
champ, éléments graphiques qui vous permettent de filtrer le contenu de la table dynamique de-
puis le diagramme lui-même, ce qui offre un gain de temps utile si la table et le diagramme sont si-
tués dans des feuilles différentes.

Référez-vous au chapitre 3, Créer des diagrammes et des graphiques du Guide Calc pour plus 
d’informations sur les diagrammes en général et les diagrammes de table dynamique, ainsi qu’au 
chapitre 8, Utiliser la table de pilote, pour plus d’informations sur les tables dynamiques elles-
mêmes.

Impression

L’impression à partir de Calc est pratiquement la même qu’à partir des autres modules de 
LibreOffice (voir le chapitre 10, Impression, exportation, envoi par courriel et signature des docu-
ments, de ce guide) mais certains détails sont différents surtout en ce qui concerne la préparation 
à l’impression.

Une fois les zones d’impression définies, elles sont formatées avec des sauts de page automa-
tiques. Pour les voir, sélectionnez Affichage > Saut de page dans la barre de menu.

Utiliser les zones d’impression

Les zones d’impression ont plusieurs utilisations, elles permettent de n’imprimer qu’une partie spé-
cifique des données, de lignes ou de colonnes sélectionnées sur chaque page. Pour plus d’infor-
mations sur les zones d’impression, voir le chapitre 6, Imprimer, exporter, envoyer par courriel et 
signer du Guide Calc.

Définir une zone d’impression

Pour définir une nouvelle zone d’impression ou modifier une zone d’impression existante :

 1) Sélectionnez la plage de cellules qui compose la zone d’impression.

 2) Choisissez Format > Zones d’impression > Définir dans la barre de menu. Les lignes de 
sauts de page automatiques s’affichent à l’écran.
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 3) Vous pouvez vérifier la zone d’impression en sélectionnant Fichier > Aperçu, en cliquant sur
l’icône Aperçu  ou en appuyant sur Ctrl+Maj+O. LibreOffice n’affichera que les cellules 
à l’intérieur de la zone d’impression.

Conseil

Le mode Affichage > Sauts de page permet également de facilement repérer la zone d’im-
pression sans passer par l’aperçu avant impression.

Ajouter une plage à la zone d’impression

Après avoir défini une zone d’impression, vous pouvez lui ajouter des cellules supplémentaires. 
Ceci permet d’imprimer plusieurs zones séparées dans la même feuille, sans avoir à imprimer 
celle-ci en entier.

 4) Après avoir défini une zone d’impression, sélectionnez la plage de cellules à ajouter à la 
zone d’impression.

 5) Choisissez Format > Zones d’impression > Ajouter dans la barre de menu. Les cellules 
supplémentaires sont alors ajoutées à la zone d’impression. Les lignes de sauts de page ne 
sont plus affichées à l’écran.

 6) Vous pouvez vérifier la zone d’impression en utilisant Fichier > Aperçu, en cliquant sur 
l’icône Aperçu  ou en appuyant sur Ctrl+Maj+O, LibreOffice n’affichera que les cellules 
à l’intérieur de la zone d’impression.

Les lignes de délimitation des pages ne s’affichent plus à l’écran.

Remarque

La zone d’impression supplémentaire sera imprimée sur une page séparée, même si les 
deux zones sont sur la même feuille.

Supprimer une zone d’impression

Il peut devenir nécessaire de supprimer une zone d’impression définie, s’il faut imprimer la feuille 
entière par exemple.

Choisissez Format > Zones d’impression > Effacer dans la barre de menu. Ceci va supprimer 
toutes les zones d’impression définies dans la feuille. Une fois la zone d’impression supprimée, les
lignes de sauts de page par défaut s’afficheront de nouveau à l’écran.

Éditer une zone d’impression

À tout moment vous pouvez éditer directement la zone d’impression par exemple pour supprimer 
ou redimensionner une partie de la zone. Choisissez Format > Zones d’impression > Éditer pour
ouvrir la boîte de dialogue Éditer les zones d’impression où vous pouvez définir celles-ci.

Options d’impression

Pour sélectionner l’ordre des pages, les détails et l’échelle :

 1) Choisissez Format > Page dans la barre de menu.
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 2) Dans la boîte de dialogue Style de page (Figure 39), sélectionnez l’onglet Feuille, et faites 
votre sélection puis cliquez sur OK.

Pour plus d’informations sur les options d’impression, voir le chapitre 6, Imprimer, exporter, en-
voyer par courriel et signer du Guide Calc.

Figure 39 : Onglet Feuille de la boîte de dialogue Style de page

Imprimer des lignes ou colonnes sur chaque page

Si une feuille s’imprime sur plusieurs pages, vous pouvez paramétrer l’impression pour que cer-
taines lignes ou colonnes soient répétées sur chaque page.

Par exemple, si les deux premières lignes, ainsi que la colonne A, doivent être imprimées sur 
toutes les pages, effectuez les opérations suivantes :

 1) Choisissez Format > Zones d’impression > Éditer dans la barre de menu. Dans la boîte de
dialogue Éditer les zones d’impression (Figure 40).

Figure 40 : Définir des lignes à répéter
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 2) Saisissez les lignes dans la boîte de saisie de texte sous Lignes à répéter. Par exemple, 
pour répéter les lignes 1 et 2, tapez $1:$2. Cela va modifier Lignes à répéter de – aucun – à
– défini par l’utilisateur -.

 3) Pour répéter des colonnes, saisissez-les dans la boîte de saisie de texte sous Colonnes à 
répéter. Par exemple, pour répéter la colonne A, tapez $A. Cela va modifier Colonnes à ré-
péter de – aucun – à – défini par l’utilisateur -.

 4) Cliquez sur OK.

Pour plus d’information sur l’édition des plages à imprimer, voyez le Guide Calc, Chapitre 6, Impri-
mer, exporter et envoyer par e-mail.

Sauts de page

Si la définition de zones d’impression peut être un puissant outil, il est parfois nécessaire d’ajuster 
manuellement l’impression dans Calc. Pour ceci, vous pouvez utiliser un saut de page manuel. Un 
saut de page manuel vous aide à vous assurer que vos données vont s’imprimer correctement en 
accord avec la taille et l’orientation de la page imprimée. Vous pouvez insérer un saut de page ho-
rizontal au-dessus de la cellule active, ou un saut de page vertical à gauche de celle-ci.

Pour plus d’informations sur les sauts de page manuels, voyez le chapitre 6, Imprimer, exporter, 
envoyer par courriel et signer du Guide Calc.

Insérer un saut de page

Pour insérer un saut de page :

 1) Activez la cellule où le saut de page va commencer.

 2) Sélectionnez Feuille > Insérer un Saut de page dans la barre de menu.

 3) Choisissez Saut de ligne pour créer un saut de page au-dessus de la cellule sélectionnée 
ou Saut de colonne pour le créer à gauche de cette cellule.

Supprimer un saut de page

Pour supprimer un saut de page :

 1) Activez la cellule près du saut de page à supprimer.

 2) Sélectionnez Feuille > Supprimer le saut de page dans la barre de menu.

 3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Remarques

Plusieurs sauts de ligne et de colonne manuels peuvent exister dans la même feuille. Si 
vous voulez les supprimer, vous devez supprimer chaque saut individuellement.

En-têtes et pieds de page

Les en-têtes et pieds de page sont des éléments de texte prédéfinis qui sont imprimés respective-
ment en haut et en bas d’une page, en dehors de la zone réservée aux cellules. Les en-têtes et les
pieds de page fonctionnent de la même façon. Pour plus d’informations sur la création des en-
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têtes et des pieds de page, voyez le chapitre 6, Imprimer, exporter, envoyer par courriel et signer 
du Guide Calc.

Les en-têtes et les pieds de page sont affectés à des styles de page. Vous pouvez définir plus d’un
style de page dans un classeur et attribuer des styles de page différents aux différentes feuilles. 
Pour plus d’informations sur ces styles, voyez le chapitre 4, Utiliser les styles et les modèles dans 
Calc, du Guide Calc.

Définir un en-tête ou un pied de page

Pour paramétrer un en-tête ou un pied de page :

 1) Sélectionnez la feuille dont vous voulez paramétrer l’en-tête ou le pied de page et choisissez
Format > Page dans la barre de menu.

 2) Sélectionnez l’onglet En-tête (Figure 41) (ou Pied de page) dans la boîte de dialogue Style 
de page.

Figure 41 : L’onglet En-tête de la boîte de dialogue Style de page

 3) Cochez l’option Activer l’en-tête (ou Activer le pied de page).

 4) Cochez l’option Même contenu sur les pages de droite et de gauche si vous voulez que le 
même texte apparaisse sur les pages de droite comme de gauche.

 5) Paramétrez les marges, l’espacement et la hauteur de l’en-tête (ou du pied de page). Vous 
pouvez aussi cocher l’option Adaptation dynamique de la hauteur.

 6) Pour modifier l’apparence de l’en-tête (ou du pied de page), cliquez sur le bouton Plus pour 
ouvrir la boîte de dialogue Bordure/Arrière-plan.

 7) Pour définir le contenu, par exemple le numéro de page, la date, etc. qui apparaîtra dans 
l’en-tête (ou le pied de page), cliquez sur Éditer pour ouvrir la boîte de dialogue En-tête (ou 
Pied de page).
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